inForm

ADV ANCED IMAGE ANALYSIS SOFTWARE

®

inForm V2.0.2
User's Manual

Notice
The information in this document is subject to change without notice and should not be construed as a commitment by
PerkinElmer, Inc. PerkinElmer assumes no responsibility for any errors that may appear in this document. This manual is
believed to be complete and accurate at the time of publication. In no event shall PerkinElmer be liable for incidental or
consequential damages in connection with or arising from the use of this manual.
This manual describes how to use inForm version 2.0.2 software.
For more information contact:
PerkinElmer, Inc.
68 Elm Street, Hopkinton, MA, 01748, USA
Phone: 800-762-4000 or +1 203-925-4602
Fax: +1 203-944-4904
Email: global.techsupport@perkinelmer.com
Web site: http://www.perkinelmer.com
This software covered by US Patent 7,555,155; 7,953,264; 8,280,140; and patents pending.

Table of Contents
.....................................................................................................
6
Chapter 1 Welcome
to inForm
..................................................................................................... 7
Chapter 2 Introduction
1 About
........................................................................................................................................
inForm
7
2 Software
........................................................................................................................................
Configurations
8
3 Key
........................................................................................................................................
Terms
10
4 Using
........................................................................................................................................
Online Documentation
11
5 Installing
........................................................................................................................................
and Starting inForm
11
6 Activating
........................................................................................................................................
the License
12
7 Contacting
........................................................................................................................................
PerkinElmer
13

.....................................................................................................
14
Chapter 3 Understanding
the inForm Work Area
1 View
........................................................................................................................................
Editor
19
2 Available
........................................................................................................................................
Images Window
21
3 New
........................................................................................................................................
Project Window
22
4 Spectral
........................................................................................................................................
Library Window
24

.....................................................................................................
26
Chapter 4 Common
Image Analysis Tasks
.....................................................................................................
27
Chapter 5 Working
with Projects and Algorithms
1 Creating
........................................................................................................................................
Projects
27
2 Opening
........................................................................................................................................
a Project
29
3 Opening
........................................................................................................................................
an Algorithm
30
4 Saving
........................................................................................................................................
an Algorithm
30

.....................................................................................................
31
Chapter 6 Opening
Images
1 Opening
........................................................................................................................................
Images in a Project
31
2 Viewing
........................................................................................................................................
Images
32

.....................................................................................................
34
Chapter 7 Drawing
Processing Regions
.....................................................................................................
35
Chapter 8 Preparing
Images
1 Selecting
........................................................................................................................................
the Image Format
35
2 Loading
........................................................................................................................................
a Spectral Library
36
3 Viewing
........................................................................................................................................
a Spectral Library
39
4 Component
........................................................................................................................................
Units
39
5 Completing
........................................................................................................................................
the Prepare Images Step
43
Contents

3

44
Chapter 9 Manual.....................................................................................................
Tissue Segmentation
1 Creating
........................................................................................................................................
Tissue Categories
44
2 Drawing
........................................................................................................................................
Tissue Category Regions
44
3 Editing
........................................................................................................................................
Tissue Category Regions
45

.....................................................................................................
47
Chapter 10 Trainable
Tissue Segmentation
1 Adding
........................................................................................................................................
Tissue Categories
47
2 Drawing
........................................................................................................................................
Training Regions
48
3 Training
........................................................................................................................................
the Tissue Segmenter
49
4 Adding
........................................................................................................................................
Images to the Training Set
51
5 Editing
........................................................................................................................................
Masks and Re-Training
52
6 Completing
........................................................................................................................................
the Automated Tissue Segmentation Step
53

..................................................................................................... 54
Chapter 11 Threshold
..................................................................................................... 57
Chapter 12 Colocalization
.....................................................................................................
59
Chapter 13 Segmenting
Cells
1 Segmenting
........................................................................................................................................
Nuclei
59
2 Segmenting
........................................................................................................................................
Cytoplasm
63
3 Segmenting
........................................................................................................................................
Membrane
64

.....................................................................................................
66
Chapter 14 Scoring
IHC or IF
.....................................................................................................
71
Chapter 15 Counting
Objects
.....................................................................................................
73
Chapter 16 Displaying
the Extracted Data
1 Viewing
........................................................................................................................................
the Color Image
73
2 Viewing
........................................................................................................................................
the Component Image
74
3 Viewing
........................................................................................................................................
the Composite Image
77
4 Viewing
........................................................................................................................................
the Tissue Segmentation Data Table
78
5 Viewing
........................................................................................................................................
the Cell Segmentation Data Table
80
6 Viewing
........................................................................................................................................
the Score Data Table
82
7 Viewing
........................................................................................................................................
the Colocalization Data Table
84
8 Viewing
........................................................................................................................................
the Count Data Table
85
9 Viewing
........................................................................................................................................
the Quant Data Table
86
10 Image
........................................................................................................................................
Options
86
11 Component
........................................................................................................................................
Stats
87
12 TMA
........................................................................................................................................
Core Info
87
13 Position
........................................................................................................................................
Stats
87
14 Shape
........................................................................................................................................
Stats
88
4

inForm - User Help

.....................................................................................................
89
Chapter 17 Exporting
the Data
..................................................................................................... 91
Chapter 18 Batch Processing
.....................................................................................................
93
Chapter 19 Merging
the Data
.....................................................................................................
94
Chapter 20 Creating
Algorithms for Vectra
.....................................................................................................
97
Chapter 21 Appendix
A: Calculating Fractional Tissue Area
.....................................................................................................
100
Chapter 22 Software
EULA
Index
.......................................................................................................... 107

Contents

5

1

Welcome to inForm
PerkinElmer's inForm® software has been developed to address the biggest challenge facing
microscopists once quantitative imagery has been acquired: extracting data. The challenge increases
when dealing with multiplexed assays, since signals can be weak and highly mixed. inForm provides a
powerful and fast solution with an intuitive, easy-to-use software interface. What might have been
impossible or have taken days, can now be done in minutes.
inForm is an advanced image analysis package that solves challenging image analysis problems by
combining fast and easy learn-by-example automated image processing with object recognition and data
analysis tools. It is based on machine learning, which means that you can train the program to create an
effective solution by simply drawing around examples of what you want segmented within the images.
inForm then creates an algorithm that you can subsequently apply across the entire image or across as
many images as you want.
PerkinElmer's multispectral images and industry-standard RGB images, including TIFF files generated
using PerkinElmer's Slide Imaging systems, can be read and analyzed by inForm.
inForm is for research use only.

Getting started – new users
Be sure to review the topics in the Introduction
specifications of the software.
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to familiarize yourself with the features and
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Introduction
The topics in this section provide basic information about inForm, what it is for, and what you can do
with it.

2.1

About inForm
inForm operates on monochrome, color, or multispectral images of tissue sections. Sections can be
stained with standard stains, immunohistochemical stains (IHC), and immunofluorescence stains (IF,
including Qdots™). Stains can be single or multiplexed for multi-analyte analyses to support
applications such as signaling pathway research in oncology.
inForm is available in different configurations, each providing additional capabilities for different
applications.
inForm Tissue Finder can be trained to find virtually any tissue type or structure, such as tumor,
fibrosis, inflammation, stroma, granuloma or vessels.
inForm Cell Analysis can be used to assess IHC or IF staining levels, on a cell-by-cell basis, for cell
prototyping. It can also generate object counts.
inForm Basic Analysis can generate area statistics and quantitative stain levels for hand-drawn or
threshold-generated regions.
inForm Viewer can visualize component data, and reconstruct the unmixed signals into a composite
image.

Features
Compatibility with PerkinElmer's multispectral images (.im3 and .im4) and with conventional color
images (.tif, .jpg, etc.).
Full range of software configurations which can include capabilities from simple tissue area
measurements to cell-as-a-unit multiplexed molecular phenotyping. To view the levels of inForm
and the capabilities of each level, see Software Configurations 8 .
Computationally efficient; runs on a standard laptop.

Specifications
Operates on PerkinElmer's multispectral images (.im3 and .im4), and monochrome or color
images (TIFF, BMP, JPEG, PNG)
Computer Specifications: Microsoft® Windows® 7, 64-bit with 8GB RAM recommended.
(Minimum: Microsoft® Windows® 7, 32-bit with 2GB RAM)

Introduction
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2.2

Software Configurations
inForm is available in four different software configurations. Each configuration enables specific tasks for
viewing, selecting, segmenting, and counting.
The following inForm software configurations are available:

Viewer
inForm Viewer includes the following features:
View images
Unmix images
View components and their signals
View a composite of the component images
Export images

Basic Analysis
inForm Basic Analysis includes all of the features available in inForm Viewer, plus the following
features:
Manually segment tissue
Create threshold maps
Create colocalization maps
Generate quantitative data for threshold and colocalization maps
Save projects and algorithms
Batch process images
Export data tables

Cell Analysis
inForm Cell Analysis includes all of the features available in inForm Basic Analysis, plus the following
features:
Use cell segmentation to identify cells and cellular compartments
Score segmented cells
Use object segmentation to identify objects

8
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Tissue Finder
inForm Tissue Finder includes all of the features available in inForm Cell Analysis, plus the following
features:
Train the Tissue Segmenter to automatically identify tissue categories
Automatically segment the image into tissue categories
Merge data files from a set of images or slides into summary data files

Steps Available in Each Software Configuration
The table below specifies which algorithm steps are available in each software configuration.

Prepare Images

Viewer

Basic Analysis

Cell Analysis

Tissue Finder

X

X

X

X

X

X

X

Manual Tissue
Segmentation
Trainable Tissue
Segmentation

X

Threshold

X

X

X

Colocalization

X

X

X

Cell Segmentation

X

X

Object
Segmentation

X

X

Score (only used
with Cell
Segmentation)

X

X

X

X

Export

X

X

Batch Processing is available with inForm Basic Analysis or higher.
Review/Merge is available with inForm Tissue Finder.
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2.3

Key Terms
The following terms describe components of inForm. You should understand the terms below when using
the software.

10

Algorithm

Algorithms include all steps in processing an image, from image preparation,
tissue segmentation and/or cell segmentation, object counting or scoring, to
export. Algorithms may also include threshold or colocalization settings,
depending on the project created to analyze the images.

Processing
Region

Processing regions are user-drawn regions of interest. Use processing regions to
only process specific regions on an image. All areas outside of the marked
processing regions are ignored.

Processing Set

A set of images that will be processed using the settings in the Manual Analysis
tab. Images in the processing set display a green square on the image thumbnail
when viewing images in Single mode. All images added to a project are included
in the processing set by default. To add or remove images from the processing
set, right-click on the large image in the image display area and click Processing
Set. You can also click the Image List Editor button to open the Available Images
window and then click the Load Images button.

Project

inForm projects include the images that were added to the project and the
settings for each step in the algorithm. A new project that contains only the
Prepare Images and Export Step is automatically created when opening inForm.
You can work in the new default project, create a new project, or open a saved
project.

Tissue Category

Tissue Categories identify structures such as tumor cells vs. healthy cells that
are present in the tissue samples. Regions in the image can be marked manually
using inForm Basic Analysis or higher. Use inForm Tissue Finder to use the
Tissue Segmenter to automatically classify tissue.

Tissue
Segmenter

The Tissue Segmenter automatically identifies regions of tissue or regions that
correspond to specific types of tissue. When you “train” a tissue segmenter, it
learns how to identify structures in the images based on the training regions
within each tissue category. The tissue regions or areas detected with the tissue
segmenter can then be segmented to detect cells and perform IHC or IF scoring,
or can be used for object counting. Only available with inForm Tissue Finder.

Training Set

The set of images that is used to train the Tissue Segmenter to identify tissue
categories automatically. Images are automatically added to the training set if a
training region is drawn on the image. To remove an image from the training set,
right-click on the large image in the image display area and click to deselect
Training Set. When an image is removed from the training set, the training regions
on the image are not used when training the Tissue Segmenter. (The training
regions are not deleted from the image, so the image can be added back to the
training set if desired.) You can also use the Available Images window to add or
remove images from the training set.
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2.4

Using Online Documentation
This manual contains detailed information about the inForm application. It is designed to be used as a
reference tool in your everyday work with inForm. The manual explains how to use inForm through
detailed explanations of features and step-by-step procedures for common tasks using realistic
scenarios. The PDF file can be read online or can be printed for reference.
inForm also includes complete documentation in an HTML-based help system, which includes all of the
information in this User’s Manual. Online help provides three ways of locating information: Use the
Contents tab to navigate through the document, the Index tab to find topics by keyword, or the Search
tab to look up topics that contain specific words or phrases.

2.5

Installing and Starting inForm
Close all applications that are running before beginning the inForm installation. Installation requires an
administrator account.
Starting the Install from CD, DVD, or USB Drive:
Insert the inForm CD, DVD, or USB drive. If AutoRun is turned on, the installation wizard starts
automatically. If the installation does not start automatically, in Windows Explorer, navigate to the install
media and double-click inFormSetup.exe.
Starting the Install from a Network or Downloading:
If you are installing inForm from a network location, download and extract the inForm installation folder to
a local drive. Double-click on inFormSetup.exe to start the installation.
Installing the Software:
Follow the wizard prompts to install the software. inForm requires the Microsoft .NET 4.5 framework. The
installer will install Microsoft .NET 4.5 if it is not already installed. The installer asks if you will be using
inForm to create Vectra® procedures to analyze Vectra data. Be sure to choose Yes if you want to be
able to create algorithms to use with the Vectra software.
Starting inForm:
Select Start > All Programs > PerkinElmer > inForm > inForm 2.0.2,
OR
double-click the inForm shortcut on the Windows desktop.
To use any software configuration other than inForm Viewer, see Activating the License

12
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2.6

Activating the License
After installing inForm, only the options for inForm Viewer are available. The customer license must be
activated to enable any purchased software options. License activation requires an administrator
account.
To activate a customer license:
1. Log into the computer using a Windows Administrator account.
2. Start inForm.
3. Select License

Activate or click the Activate button. The Activation window opens.

4. Enter your 20 character license number.
5. If available, use the online activation method to complete your activation.
6. If online activation is not available, click the Copy to Clipboard button to copy the text onto the
Windows clipboard.
7. Email the copied text to the email address shown in the Activation window.
8. Click the Cancel button to close the Activation window.
9. Wait to receive the email that contains the text for the response key.
10.Start inForm and select License

Activate. The Activation Window opens.

11.Type or paste the response key from the email into the Activation window and click the OK
button. inForm displays a restart message.
12.Click the OK button. inForm restarts automatically. The purchased options are now available in
the software.

Transferring a Software License
You can transfer the license from the current computer to another computer. When the license is
transferred to the new computer, the license is removed from the current computer, leaving only the
inForm Viewer options.
Transferring a license requires an administrator account on both machines, a USB thumb drive, and an
available USB port on each machine.
To transfer the license, log into the unlicensed computer with an administrator user name and password.
Start inForm and select License
Activate. Choose Transfer. Follow the instructions provided in the
dialog boxes to complete the transfer.

12
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2.7

Contacting PerkinElmer
For more information, contact PerkinElmer or your local authorized PerkinElmer distributor:
PerkinElmer, Inc.
68 Elm Street, Hopkinton, MA, 01748, USA
Phone: 800-762-4000 or +1 203-925-4602
Fax: +1 203-944-4904

PerkinElmer Web Site:
http://www.PerkinElmer.com
Technical Support Email:
global.techsupport@perkinelmer.com
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3

Understanding the inForm Work Area
The inForm work area contains the step bar, process editor panel, image display toolbar, and image
display area. The example below shows the Manual Analysis tab with a brightfield image that has been
segmented into two tissue categories.

Figure 1. inForm Work Area with Image Showing Segmented Tissue

A. Step Bar
The Step bar displays an icon for each processing step included in the project that is open in the
Manual Analysis tab. The Step bar only displays when the Manual Analysis tab is selected. A new
project is automatically created when inForm opens. By default, the new project only includes the
Prepare Images and Export steps. To create a new project with additional steps, see Creating
Projects 27 . To add, remove, or change the steps in the open project, see Configure a Project 28 .
Click the icons in the step bar at the top of the work area to display the settings for each step in the
Manual Analysis tab. For example, click Prepare Images to display the Image Preparation
Settings panel in the Manual Analysis tab; click Export to display the Export Settings panel.
Configure button - Opens the Configure Project window to change the steps in the
current project. See Creating Projects 27 for instructions. Vectra® Tissue Finder and
Vectra HPF Finder projects cannot be configured.
Prepare Images - Use to specify the image format and sample format, change the
image resolution, load a spectral library, convert images to optical density, and unmix
images. See Preparing Images 35 for instructions.
Manual Classification - Use to create tissue categories and manually draw tissue
regions on the images in the project. Exported data includes position, shape, and
component signal statistics for each segmented tissue region. See Manual Tissue
Segmentation 44 for instructions. This feature is available with inForm Basic Analysis

14
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or higher.
Segment Tissue - Use to train the automated tissue segmenter and automatically
segment the images. Exported data includes position, shape, and component signal
statistics for each segmented tissue region. See Trainable Tissue Segmentation 47 for
instructions. This feature is only available with inForm Tissue Finder.
Threshold - Use to create and analyze threshold maps. Exported data includes
position, shape, and component signal statistics for each thresholded region. See
Threshold 54 for instructions. This feature is available with inForm Basic Analysis or
higher.
Colocalize - Use to create and analyze colocalization maps. Exported data includes
position, shape, and component signal statistics for the colocalization region, as well
as position, shape, and component signal statistics for the underlying component
regions. See Colocalization 57 for instructions. This feature is available with inForm
Basic Analysis or higher.
Segment Cells - Use to segment cell nuclei and optionally segment cytoplasm and
membrane. Exported data includes position, shape, and component signal statistics for
each segmented cell. See Segmenting Cells 59 for instructions. This feature is
available with inForm Cell Analysis or higher.
Score IHC or IF - Use to quantify IHC or IF staining levels in segmented cells. The
tools provided are intended to automate visual assessment (Positivity, 0-3+, 10-bin, 50bin, and Double Positivity) and to provide histogram data of staining levels. Exported
data includes the score for each selected cell compartment. See Scoring IHC or IF 66
for instructions. This feature is available with inForm Cell Analysis or higher.
Count Objects - Use to segment objects other than cells. Exported data includes the
position, shape, and component signal statistics for each segmented object. See
Counting Objects 71 for instructions. This feature is available with inForm Cell Analysis
or higher.
Export - Use to select the export directory, the images to export, the data to export,
and the file name options. See Exporting the Data 89 for instructions.

B. Manual Analysis Tab
The Manual Analysis tab on the left displays the settings for each step. Use these panels to select
the settings for the algorithm or project. These settings can only be edited when viewing a single
image, and not while viewing images in Gallery mode. See also Image Display Area 18 .

Understanding the inForm Work Area
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C. Toolbar
The toolbar enables you to adjust the image zoom level, draw processing regions, draw training
regions, and adjust the view settings. The tools available on the toolbar change based on the current
processing step. The toolbar displays in the Manual Analysis tab.
Select: Return the cursor to the default pointer mode.

View Component Data: Hover over the image to display the signal intensity of each
component at any location.
Zoom In: Click on the image to re-center the image and to zoom in. Click and drag to
zoom in on a specific region of the image.
Zoom Out: Click on the image to re-center the image and to zoom out. Double-click the
image with this tool to return magnification to 100%.
Zoom to Full: Click to view the image at 100%.

Pan: Click and drag the image to view the desired region in the window.

Draw Processing Regions: Click and drag to outline the desired processing region.
Only the areas of the image within the processing regions are analyzed.
Delete a Region: Click inside a processing or training region to remove the region.

Draw Training Regions: Click and drag to identify regions of the image that represent
the selected tissue category when training the tissue segmenter. This tool selects
automatically when you select a tissue category from the category list. When in draw
mode, you can continue drawing training regions. Only available during the Segment
Tissue step.
Draw Classification Regions: Click and drag to identify regions of the image that
contain the selected tissue category. Only available during the Manual Classification
step.
Select Regions to Unclassify: Click and drag to outline the area on the image to
unclassify. Only available during the Manual Classification step.
Select Pixels to Unclassify: Click and drag over the specific pixels to remove from the
classification region. Only available during the Manual Classification step.
White Picker: Click on a white area on a Brightfield image to select the white
background spectra prior to converting the image to OD (optical density). Available only

16
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during the Prepare Images step.
Add to Thresholded Regions: Click the button to select the desired unmixed
component and then click and drag to outline the area on the image to be added to the
selected threshold map. Only available during the Threshold step.
Erase Thresholded Regions: Click the button to select the desired unmixed
component and then click and drag to outline the region to remove from the threshold
map. Only available during the Threshold step.
Edit the Tissue Segmentation: Click the button to select the tissue
category and then click and drag to manually draw the selected tissue
category over an area. After segmenting the images, inspect the images to
make sure the tissue regions are segmented as you intended. If areas are
under the wrong masks (the tumor mask over non-tumor cells, for example),
use this tool to draw the desired mask over an area. Only available during the
Segment Tissue step. Select Clear Edits to clear all manual edits to the
tissue masks.
View Editor: Click to open the View Editor Window 19 to choose the type of image or
table to view and to change the display settings. You can also view or hide cells, masks,
and regions. Buttons to quickly show or hide image maps are available on the left side of
the image display area.
Image List Editor: Click to opens the Available Images Window 21 to add images to or
remove images from the open project, the processing set, or the training set.

Show/Hide Map Options: Click to show or hide the image maps. You can show or hide
segmentation maps, training regions, and processing regions. (The Show/Hide options are also
available on the View Editor 19 .) The buttons include:
Tissue Segmentation Map - Click to show/hide the Tissue Segmentation Map.
Nuclear Segmentation Map - Click to show/hide the Nuclear Segmentation Map.
Cytoplasm Segmentation Map - Click to show/hide the Cytoplasm Segmentation Map.
Membrane Segmentation Map - Click to show/hide the Membrane Segmentation Map.
Training Regions - Click to show/hide the Training Regions.
Processing Regions - Click to show/hide the Processing Regions.

Understanding the inForm Work Area
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D. Image Display Area
The image display area in the Manual Analysis tab has two modes -- Single and
Gallery.
Single mode displays one image in the large Image area, and displays a row of
thumbnails of all other open images below the large image. Click any thumbnail to
view the image in the display area. A blue square on a thumbnail indicates that the
image is included in the training set; a green square indicates the image is in the
processing set. The Algorithm settings in the left-hand panel can only be edited in
Single mode.
Gallery mode displays all the project images in the large Image area. Use the
Image Size slider at the top of the workspace to adjust the number of open images
shown in the image display area. In Gallery mode, all Algorithm settings are readonly. Gallery mode is for image and table review only; you cannot edit the
Algorithm settings in this mode.

Right-Click Shortcut Menu
The following actions are accessible by right-clicking on an image in the Image
Display area:
Save: Saves a copy of the image (as shown in the Image Display Area) to a file in
the selected format (.tif, .jpg, .png, .gif, or .bmp). (Default is the last selected
image format.)
Delete Region: Deletes the region that you right-clicked on. (Only available if you
right-clicked on a region.)
Delete Regions: Provides options to delete all training regions, all processing
regions, or both, from an image. (Only available if training regions and/or
processing regions have been created on the image.)
Show Regions: Provides options to show/hide all training regions, processing
regions, or both, on an image.
Processing Set: Adds or removes the image from the processing set. If checked,
the image is included in the processing set. If cleared, the image is not included in
the processing set. Click on the option to toggle the check mark.
Training Set: Adds or removes the image from the training set. If checked, the
image is included in the training set. If cleared, the image is not included in the
training set. Click on the option to toggle the check mark. Only displays if training
images have been drawn on the image. (Draw training regions on the image or use
the Available Images Window 21 to add images without training regions to the
training set.)
View Editor: Opens the View Editor

19

to select the display options.

Remove from Project: Removes the image from the project.
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E. Batch Analysis Tab
After a suitable project or algorithm for processing images has been created, validated, and saved,
use the Batch Analysis tab to process large numbers of images. Use the Batch Analysis Editor 91
to select a project or an algorithm for batch processing, select export directory/folder preferences,
and select the image/table options. (This feature is available with inForm Basic Analysis or higher.)

F. Review/Merge Tab
After completing a batch run, which often generates large numbers of output files, use the Review/
Merge Editor 93 to combine the data from multiple output files into a single file for detailed and
quantitative analysis. The Review/Merge Editor 93 has tools to filter out data from samples that are
inadequately prepared, stained, and/or segmented, so that merged data sets are reliable. (This
feature is only available with inForm Tissue Finder.)

3.1

View Editor
Use the View Editor to select the display options for images or data tables after processing. The images
and data tables available are determined by the steps in the project. The steps available are determined
by the inForm license. This section lists the views that are available for each software configuration. For
definitions of the options, see Displaying the Extracted Data 73 . To open the View Editor, click the
View Editor button on the image toolbar.

Views Available In Viewer
Color Image: Shows the original color image
plus the regions selected in the Image
Options.
Component Image: Shows an image of a
single unmixed component.
Composite Image: Shows a reconstructed
image of all components.

Views Available In Basic Analysis
Includes all views in Viewer, plus:
Tissue Segmentation Data: This table is
available when an algorithm contains a manual
segmentation step. The table provides
information on the manually segmented tissue
regions. (See Viewing the Tissue
Segmentation Data Table 78 for detailed
information.)

Figure 2. View Editor

Understanding the inForm Work Area
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Quant Data: This table is available when an algorithm contains a threshold or colocalization
step. The table provides information on the thresholded regions. (See Viewing the Quant Data
for detailed information.)

86

Colocalization Data: These tables are available when an algorithm contains a colocalization
step. (See Viewing the Colocalization Data 84 for detailed information.) There are three tables:
Colocalization Table: Shows colocalization data of the selected components and positivity
data for each selected component.
In Channel Table: Shows the positivity of one component within another for all selected
colocalization components.
Quant Table: Shows stats for the whole image and colocalization region.

Views Available In Cell Analysis
Includes all views in Basic Analysis plus:
Cell Segmentation Data: This table is available when an algorithm contains a cell
segmentation step. The table provides information on the segmented cells. (See Viewing the Cell
Segmentation Data 80 for detailed information.)
Object Segmentation Data: This table is available when an algorithm contains an object
segmentation step. The table provides information on the segmented objects. (See Viewing the
Count Data 85 for detailed information.)
Score Data: This table is available when an algorithm contains a score step. The available data
changes depending on the type of scoring (positivity, 0-3+, 10-bin, 50-bin, and Double Positivity).
(See Viewing the Score Data 82 for detailed information.)

Views Available In Tissue Finder
Includes all views in Cell Analysis. Tissue Segmentation data displays in the Tissue
Segmentation Table. (See Viewing the Tissue Segmentation Data 78 for detailed information.)

20
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3.2

Available Images Window
Use the Available Images Window to view a list of
all images in the project and to add images to or
remove images from the processing set or the
training set. (The training set is only supported in
inForm Tissue Finder when training the Tissue
Segmenter.) Click the Image List Editor button
to open the Available Images window.

To load additional images into the project, click
the Load Image button. The new images must
be compatible with the Prepare Images settings in
the current project. New images must have the
same spectral wavelength characteristics as the
existing images in the project.
To remove an image, right-click on the image
name and click Remove.

Figure 3. Availab le Images Window

Understanding the inForm Work Area
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3.3

New Project Window
Use the New Project Window to select the steps to include in the project. Certain steps are only
available if a software option has been purchased and installed. (For available software configurations,
see Software Configurations 8 ).

Figure 4. New Project Window

The New Project window contains the following options and buttons:
Project Type - These options only display in inForm Tissue Finder if you chose to enable Vectra
algorithms when inForm was installed. If these options are not displayed, all new projects are Custom
Projects.
Custom Project option - Creates an inForm project with the selected steps.
Vectra Tissue Finder Algorithm - Creates an algorithm to use in the Vectra software to identify
areas of tissue. See Creating Algorithms for Vectra 94 for details.
Vectra HPF Finder Algorithm - Creates an algorithm to use in the Vectra software to identify areas
of tissue where images should be taken using the high power objective. See Creating Algorithms for
Vectra 94 for details.
Prepare Images - Required for all projects. Specifies the Image Format and Sample format, changes
the image resolution, loads a spectral library, unmixes the spectral components, and removes haze from
the images. See Preparing Images 35 for details.
Segment Tissue - Segment the image into specific tissue categories.
Manual Tissue Segmentation - Tissue categories are manually drawn on each image. See
Manual Tissue Segmentation 44 for details.
Trainable Tissue Segmentation - The tissue segmenter is trained to identify different tissue
types in the images. Processing the images automatically assigns the appropriate tissue
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categories. See Trainable Tissue Segmentation
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for details.

Find Features - Find features in the images using thresholds or segmentation algorithms.
Cell Segmentation - Identifies individual cells or subcellular objects in the image using either
thresholded or algorithmic segmentation. See Segmenting Cells 59 for details.
Object Segmentation - Identifies objects on an image using either thresholded or algorithmic
segmentation. See Counting Objects 71 for details.
Colocalization - Identifies regions on an image where multiple unmixed component thresholds
overlap. Threshold values for each component are specified individually. See Colocalization 57 for
details.
Threshold - Identifies regions on an image where a component is above a specific threshold. See
Threshold 54 for details.
Score - Score cells based on intensity thresholds.
Scoring - Scores the segmented nuclei, cytoplasm, and/or membrane to count the percent
positive of a specific component above a specified threshold. See Scoring IHC or IF 66 for details.
Export - Required for all projects. Specifies the export settings for images and data tables after
processing is complete. See Exporting the Data 89 for details.
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3.4

Spectral Library Window
Use the Spectral Library window to view charts of the emission spectral curve for each stain selected for
unmixing. Viewing the spectral library can help when troubleshooting unexpected unmixing results.
Ideally, the spectra should be easily distinguishable in each of the imaging bands. Typically, one filter is
used for each stain. If the Spectral Library uses multiple filters, one chart displays for each filter. The
figure below shows a spectral library with DAPI, CY3, and CY5 with good separation in each chart. The
Spectral Library window updates dynamically if the Image Preparation Settings are changed.
To open this window, click the View button under the Spectral Library list box in the Prepare Images
step after selecting a spectral library.

Figure 5. Spectral Lib rary with multiple filters

Spectral Library Name: For multispectral .im3 images and RGB images, displays the name of the
current spectral library above the charts. The Spectral Library name is not displayed for TRIO .im4
images because the spectral library is embedded in the image cube and does not have a separate file
name.
Charts: The spectral library display can contain multiple charts; one chart for each imaging band. Each
chart displays the spectral segments within an imaging band. Brightfield images only have one imaging
band, so only one chart displays. After loading a library, select the check boxes for the spectra you
want to use for unmixing in the Prepare Images step. The Spectral Library window automatically updates
to show only the selected spectra. For TRIO (.im4) images, all spectra are selected for unmixing and the
selections cannot be changed. Hovering over the line in a spectral curve displays the name, wavelength
(x value), and signal strength (y value) of the nearest data point. By default, the charts open with Unmix
Units and Scale to Max (equal scales) selected.
X Axis: Spectral wavelength of light in nanometers.
Y Axis: The units selected in the Units drop-down list.
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Units drop-down list: Specifies the units on the Y Axis on the charts. Only the units valid for the
spectral library are available. For example, if a spectral library does not contain Raw units, the Raw
option is not available.
Raw Counts: Pixel intensity in unit counts. Typical Fluorescence values are from 0 to 4095.
Typical Brightfield values are from 0 to 255.
Unmix Units: Displays the signal used for unmixing. Can show artifacts that are not visible in
other views. Usually the best unit for evaluating a spectral library.
Normalized for Exposure: Signal is displayed in counts/second. Used to compare signal
strength across bands. (Fluorescence libraries only)
OD: Optical Density units (Brightfield libraries only)
Display drop-down list - Specifies the Y Axis scaling option for the charts.
Scale to Max (equal scales): All charts are scaled to the same value, which is the maximum
signal value in all of the bands.
Scale to Max (varying scales): Each chart is scaled individually to the maximum signal unit for
that chart. (This option is not available when there is only one imaging band, when the library is
for a brightfield image, or when the units are OD.)
Normalized: Each chart is scaled individually on the Y Axis to 1. Additionally, the signals are
scaled so each spectrum has a maximum of 1. (This option is not available when units are Unmix
Units.)
Save Chart Button: Opens the Save Chart window to specify the location, name, and file format for
saving a graphic of the charts displayed in the Spectral Library window. The chart can be saved as a
.bmp, .gif, .png, .tif or .jpg and saved to a computer or network location. The graphic file includes the
legend.
Legend: Displays the color for each stain in the chart. The colors are selected when the Spectral
Library is created and cannot be changed in this view.
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4

Common Image Analysis Tasks
Use inForm to create automated image analysis routines to accurately extract data from PerkinElmer's
TRIO, Nuance, or Vectra images, or conventional RGB images (TIF, BMP, or PNG). (While it is also
possible to process JPG images, this is not recommended. JPGs can contain compression artifacts
that could adversely affect segmentation performance.)
Some common inForm image analysis tasks:
inForm performs pixel-based analysis to quantitatively obtain component data. inForm can set
thresholds (pixel-based) for all component signals and quantitate the thresholded component
signals.
inForm performs colocalization, which locates areas where components are simultaneously
expressing on a pixel level.
inForm identifies cells and finds nuclei, membrane, and cytoplasm, quantitates the component
signal within those cell compartments and calculates consistent scoring judgments based on that
quantitation.
inForm identifies non-cellular objects, and can provide quantitative statistics.
inForm can automatically identify tissue types based on training regions drawn by the user.
Features can be combined to perform more advanced analysis, such as computing the double positivity
of cells within a cancer region, or computing the colocalization of a multi-stained tissue sample.
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5

Working with Projects and Algorithms
An inForm project includes the images in the project, the algorithm to process the images, and any
processing regions, training regions, or manual tissue regions.
The topics in this section describe how to create, open, and save projects, how to change the project
settings, and how to open and save an algorithm.
An algorithm is used in batch mode to process images the same way each time. A project includes all the
images so that you can go back and modify algorithm settings, including the trainable tissue classifier.

5.1

Creating Projects
Each time inForm starts, a new project is created automatically. The new project contains only the
Prepare Images step and the Export step. To create a project with additional steps, either Create a
New Project 27 or Configure the Open Project 28 . The name of the current project displays in the
inForm title bar. Specify the desired project name when creating a new project or when configuring the
project.

Create a New Project
The steps available when creating a new project are determined by the software configuration used
to create the project. See Software Configurations 8 for information on the features available for
each software configuration. (To create algorithms for use with Vectra, see Creating Algorithms for
Vectra 94 . The Vectra options are only available if inForm Tissue Finder was configured during
installation for use with Vectra images.)
To create a new project:
1. Select File > New > Project. If an unsaved project is open already, inForm prompts you
to save the current project. If you choose No, all unsaved settings are lost. The New
Project window opens as shown in the figure below. Prepare Images and Export are
automatically included in all projects.

Figure 6. New Project Window
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2. Type a name for the new project in the New Project Name text box.
3. To segment tissue, select the desired option under Segment Tissue:
a. Select Manual Tissue Segmentation to manually mark tissue categories on the
images.
b. Select Trainable Tissue Segmentation to train the tissue segmenter to
automatically identify areas as specific tissue categories.
c. Select Skip This Step to skip tissue segmentation.
4. To find specific features, select the desired option under Find Features:
a. Select Cell Segmentation to identify cellular features, such as finding the nucleus,
cytoplasm, and membrane for each cell.
b. Select Object Segmentation to identify objects of interest.
c. Select Colocalization to identify areas on the images where selected components
are colocated.
d. Select Threshold to identify the areas on the images where the strength of a
component at each pixel exceeds a specific threshold.
e. Select Skip This Step to skip finding features.
5. If Cell Segmentation was selected, select Scoring to calculate score statistics for the
cells.
6. Click the Create button to create a new project with the selected steps.
7. See Opening Images
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to add the desired images to the project.

Configure a Project
You can configure a project to add or remove steps from the project. inForm retains as many
settings as possible, depending on which steps are added or removed from the project. For
example, if you created a project without tissue segmentation and later decide that you want the
project to include manual tissue segmentation, you can modify the project to add Manual Tissue
Segmentation. Settings that are not affected by the changes are retained, but some settings may
need to be adjusted due to the changes to the project. You cannot reconfigure a Vectra project and
you cannot convert a non-Vectra project into a Vectra project.
The steps available when configuring a project are determined by the software configuration used to
configure the project. See Software Configurations 8 for information on the features available for
each software configuration.
1. Select Tools > Configure Project or click the Configure button.
2. Use the Configure Project window to select the desired steps. The Configure Project
window contains the same options as the New Project Window 22 .
3. Click the Configure button and inForm reconfigures the project.
4. Verify that all of the desired settings are selected in each step.
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5.2

Opening a Project
To open a saved inForm project:
1. Select File > Open > Project, select the name of the project, and click the Open button. The
images in the project open in Gallery mode as shown in the figure below. The View Editor and
the Available Images window close if either one was open in the previous project.

Figure 7. Gallery View

2. To edit algorithm settings, click the Single button to change to Single mode.

Saving Projects
Saved projects include the images, the algorithm to process the images, and any processing
regions, training regions, or manual tissue regions.
1. Select File > Save > Project.
2. Type a new file name, if desired, select the desired location, and click Save. A project file (.ifr)
is saved in the specified location. A folder named <ProjectName>_TrainingImages is created in
the same folder as the project file. Local copies of all the images in the project are saved in the
training images folder. (To save only the algorithm and not the images, see Saving an Algorithm
30 .)

Changing Settings
After a project has been created, the settings in the steps can be changed. Changing settings may
require you to reprocess the images for later steps in the project.
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5.3

Opening an Algorithm
Algorithms include all steps in processing an image: image preparation, image analysis, and export.
You can load an algorithm into inForm and then open the images you want to process, or load the
images first, and then apply the algorithm.
Algorithms can be used in Batch Processing 91 to automatically process multiple images at the same
time using the same analysis settings. If a project is opened for use in Batch Processing, the project's
algorithm is used to process the images.
To open an algorithm, select File > Open > Algorithm. If a project or image is already loaded, inForm
warns you that all images will be reset to their initial state. Click Yes to discard all training regions,
tissue regions, cell regions, object regions, thresholds, and component images. Select the desired
algorithm, and click Open.
Open the desired images if they are not already open. To prepare the image(s), click the Prepare
Image or Prepare All button. To review or change the settings in each algorithm step, click the
Advance button to advance through each step or click the step buttons at the top of the window.
When algorithm development is complete, see Saving an Algorithm

5.4
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Saving an Algorithm
inForm Algorithms allow you to reuse the same settings to process compatible images or sets of
images without re-selecting the settings for each new project. (Saving the project saves the images with
the steps, see Saving a Project 29 .)
To save the algorithm, select File > Save > Algorithm. Or to save the algorithm in a protected format
that cannot be edited, select Locked Algorithm. Type the desired algorithm name, select the desired
location, and then click Save.
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6

Opening Images
The topics in this section describe how to open images in a project and describes the viewing options
available.

6.1

Opening Images in a Project
Add the images to the project as described below. The images in a project can be included in the
Processing set (the images to be processed by the algorithm) and/or can be included in the Training set
if training a Tissue Segmenter.
The number of images that can be opened in a project depends on the size of the images (width and
height in pixels) and the operating system. Windows 7 32-bit systems can open up to 20 Nuance-sized
images (1392x1040). Windows 7 64-bit systems can open up to 400 Nuance-sized images.

Opening Images
To open the desired images:
1. Select File > Open > Image. The Select Image window opens. The Files of Type selector
at the bottom of this window specifies the types of image files to display: Multispectral files
(.im3), TRIO images (.im4), or other common image files such as TIFFs, BMPs, JPGs, etc.
2. Navigate to the location of the image files.
3. Select the desired image files. The image files must all be of the same image type
(.im4, .im3, RGB, or Monochrome). Ctrl + click to select multiple image files. Shift + click to
select a range of files.
4. Click the Open button to add the images to the project. The images are automatically
included in the Processing set 10 .
5. To change the view of the images, see Viewing Images

32 .

6. To process only part of an image, see Drawing Processing Regions

34 .

7. To change the image resolution, convert to optical density, or unmix the images, see
Preparing Images 35 .

Opening Images Using the Available Images Window
You can add images to the project using the Available Images window.
1. Click the Edit the list of images button on the button bar. The Available Images Window
21 opens.
2. Click the Load Image button. The Select Image window opens,
3. Select the desired images and click the Open button.
You can also use the Available Images window to select which images are in the training and
processing sets by selecting or clearing the check boxes next to each image name.
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Adding Additional Images to a Project
After images have been added to a project, only files of the same type (Multispectral, TRIO, RGB,
or Monochrome) can be added to the project. Add images to an open project either by selecting
File > Open > Image or by clicking the Load Image button in the Available Images Window 21 .

Removing Images from a Project
To remove images from the open project:
In Single mode, click on the thumbnail of the image to be removed to show the image in the
Image Display Area. Right-click on the image in the image display area and select Remove
from Project.
In Gallery Mode, right-click on an image in the gallery and choose Remove from Project.
Images can also be removed from the project by right-clicking on the image name in the Available
Images Window 21 and selecting Remove Image.

6.2

Viewing Images
Images are viewed in the Image Display area in the inForm Window. View images in Single Mode to
zoom in on an image, draw regions on an image, or edit the algorithm settings. View images in Gallery
Mode to compare all the images in the project or to quickly locate specific images.

Gallery Mode
To view a gallery of images, click the Gallery button at the lower left of the display area. Note that when
in Gallery mode, you cannot edit the Step settings.

Adjust the display by moving the Image Size slider at the top of the Image Display Area. Move the
slider to the left to fit more images in the display area. Move the slider to the right to fit fewer images in
the display area.
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Figure 8. Gallery View

Single Mode
To view an image in Single Mode, click the Single button at the lower left of the display area.

Click on the thumbnail of the image to view the image in the display area.

Figure 9. Single View
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7

Drawing Processing Regions
Processing regions enclose areas of the image that will be processed using the steps in the project or
algorithm. Areas of the image outside of the processing regions are ignored and are not included in any
calculations or statistics. Processing regions are manually drawn on the images and cannot be used for
Batch Processing 91 .
To draw processing regions on an image:
1. In the open project, click the Single Mode button, and then click on the desired image in the
image thumbnails.
2. If desired, use the Zoom In button to zoom in on the image or the Pan button to move the image
in the image display area.
3. Click the Draw Processing Region button on the toolbar.

4. Click and drag to outline the desired area of the image. Release the mouse button to connect the
endpoint to the start point of the processing region. An ID number is assigned to the processing
region and displays in the middle of the region. The ID number identifies the region in data tables.
5. Repeat step 4 to draw multiple processing regions on the same image.
6. Click on each image and repeat steps 2 through 5 to define all desired processing regions on
each image in the project.

Deleting Processing Regions
If a processing region doesn't enclose the desired region, delete the processing region and draw a new
processing region.

To delete a processing region:
1. Click the Remove Processing Regions button on the toolbar.

2. Click on the processing region that you want to delete. The processing region is removed and the
remaining processing regions with ID numbers higher than the deleted region are re-numbered.
You can also delete a processing region by right-clicking on the processing region and selecting
Delete Region on the shortcut menu.

To delete all processing regions on an image:
1. Right-click anywhere on the image.
2. Select Delete Regions > Delete Processing Regions on the shortcut menu.
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8

Preparing Images
The first processing step in an algorithm is the Prepare Images step. This section describes how to
prepare the images for segmentation or analysis by changing image resolution, converting brightfield
images to optical density, and unmixing the images.

8.1

Selecting the Image Format
The Image Preparation Settings panel displays the Image Format, Sample Format, and Change
Resolution options.

Figure 10. Image Format and
Sample Format

Image Format
Before image analysis can begin, inForm needs to know the type of images in the project. Possible
image types are Multispectral (.im3), TRIO (.im4), RGB, or Monochrome.
If you open a new project and then immediately add new images to the project, inForm automatically
selects the correct Image Format (Monochrome, RGB, Multispectral (.im3), or TRIO (.im4). If you open
TIFF, BMP, or PNG images, inForm recognizes the images as either RGB or Monochrome images.

Sample Format
All images in the project must be the same sample format. For any RGB images and for Multispectral
(.im3) images created with early versions of Nuance, you must select the correct Sample Format
(Brightfield or Fluorescence). Monochrome images do not use a Sample Format. For all other image
formats, inForm automatically detects the Sample Format. For some image types, you can change this
selection if desired.
If desired, you can select the Image Format and Sample Format before adding images. In this case, only
images that match the selected Image Format and Sample Format can be opened.

Change Resolution
Select the Change Resolution check box to change the image resolution. Lower the image resolution
to increase the speed of training and tissue segmentation. If the set of images is so large that all of the
images cannot be held in memory, lower the image resolution prior to unmixing.
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8.2

Loading a Spectral Library
inForm uses a process called spectral unmixing to decompose the image into its various components.
For a simple example, a color image can be unmixed into its red, green, and blue components. But
more powerfully, an image can also be unmixed into its stain components such as Hematoxylin and
DAB for Brightfield images, which describe the contribution of each stain to the overall signal. The
contributions of each stain are based on a spectral library that shows the characteristic color distribution
of light associated with each stain. A fluorescence example could consist of stain components such as
DAPI and FITC; the spectral library can additionally include the color distribution associated with tissue
autofluorescence.
TRIO multispectral .im4 images contain the spectral library, which is automatically selected
when the first .im4 file is opened in the project.
For Fluorescence multispectral .im3 images, the spectral library is created in the Nuance
software.
For Brightfield multispectral .im3 images, the spectral library is created in the Nuance
software.
For RGB images, the spectral library can be created in the Nuance software or you can use the
default RGB spectral library that is included with inForm.
For Monochrome Images, spectral libraries are not used.
To select the spectral library:
1. For Brightfield RGB or for multispectral .im3 images
acquired with early versions of Vectra, convert to
Optical Density as described in Converting to Optical
Density 37 (below). Images acquired with recent
versions of Vectra are already converted to Optical
Density.
2. Click the Browse button and select the desired
Spectral Library (.csl). The name of the selected
library displays. The components in the library display
in the Spectra for Unmixing list box.
3. For fluorescence images, see Remove Haze 38 for
details on removing the background haze before
unmixing.
4. In the Spectra for Unmixing list box, select the
check boxes for the components that you want to
unmix.
5. To view the selected Spectral Library, click the View
button under the Spectra Unmixing list box and see
Viewing a Spectral Library 39 .
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Figure 11. Load Spectral Lib rary

Converting to Optical Density
Brightfield multispectral and RGB images of IHC-stained
samples need to be converted to optical density if the goal
is to quantify stain "intensity" (optical density). Typically,
brightfield multispectral images acquired with Nuance and
recent versions of Vectra are already converted to optical
density and do not need conversion as part of Prepare
Images. Brightfield multispectral images acquired with
early versions of Vectra are not converted to optical
density when acquired, and require conversion as part of
Prepare Images.

Figure 12. Convert to Optical
Density

Selecting a "Reference White" for Optical
Density conversion:
1. Select the Convert to Optical Density check box.
2. If the white areas on the image are small, zoom in on
a white area.
3. Click the White Picker button.
4. Move the cursor (a white box) over a white region on the image and click. “White Selected”
displays under the Convert to Optical Density check box. If the image appears very light, you
may have clicked on an area that was not completely white. Clear the Convert to Optical
Density check box to return to the original image, and then repeat the steps above.
Note:

The optical density conversion is required if you are working with brightfield images and
plan to segment cells and measure stain intensity.

Choosing Spectra for Unmixing
The Spectra for Unmixing list box is populated from the
selected spectral library. Select the check boxes for the
signals to unmix. For fluorescence images, see the
Remove Haze 38 topic first to remove the background
haze before unmixing.
For Brightfield RGB images, if you do not load a library,
the spectra for unmixing default to Blue, Green, and Red.

Figure 13. Spectra for Unmixing
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Removing the “Haze” Signal
In fluorescence images, image contrast and unmixing
accuracy can sometimes be improved if the general haze
in the image, which has a characteristic spectra, is
subtracted from the images first. When creating the
spectral library for the images, create the background or
“haze” spectrum and add it to the library. When the library
is loaded, you can select the haze spectrum and remove it
from the images.

To remove haze:
1. Check the Remove Haze check box.
2. Select the Haze Spectrum to remove.
Haze is removed numerically (without scaling or other
changes in value), wavelength-by-wavelength, from every
pixel of the image. This alters the spectral shape of the
remaining signals and their overall intensity. The
magnitude of these changes depends on the intensity of
the spectral signal being subtracted. Typically, when
background spectra are small compared to the signals,
spectral library entries derived from unsubtracted data sets
can still be used, but this should be validated when
quantitative results are required. Ideally, the remaining
spectra in the library should also have the haze spectrum
subtracted (in Nuance).

38

inForm - User Help

Figure 14. Remove Haze
Spectrum

8.3

Viewing a Spectral Library
The Spectral Library window displays a chart for each spectral segment in a spectral library.
To view the spectral library:
1. Open the desired images and spectral library.
2. Select the spectra that will be used to unmix the images in the Spectra for Unmixing list box.
3. Click the View button below the Spectra for Unmixing list box to open the Spectral Library
Window 24 .
4. Select the desired Units to display the stains in the charts. See Spectral Library Window
complete descriptions.

24

for

5. Select the desired Display options for the chart(s).
6. To save an image of the chart with the currently selected display options, click the Save Chart
button, type the desired name for the image file, select the desired image format, and click the
Save button.
7. Click the Close (X) button in the upper right corner to close the Spectral Library window.
If a chart cannot be displayed because no spectra are selected or there are no compatible units, a
message displays in place of the spectral charts.

8.4

Component Units
The components produced by unmixing are calculated
using the settings selected in the Select Reported Units
and Weighting drop-down lists. The Reported Units can
be: Raw counts, counts Normalized for Exposure, or OD
(optical density) units. The Weighting can be Total, Mean,
or Peak.

Brightfield versus Fluorescence
Brightfield and Fluorescence images use different measuring schemes because of the inherent
differences of the images.
For Brightfield images, darker pixels indicate a higher expression of the biomarker.
For Fluorescence images, brighter pixels indicate a higher expression of a biomarker or reporter
protein.
Therefore we use optical density for brightfield images and fluorescence counts (either raw or
normalized) for fluorescence images.
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Select Reported Units
Monochrome (black and white) images and RGB color images produce signals in counts.
For multispectral images that are not converted to optical density, component signal counts are
either raw or normalized for exposure.
Raw Counts reports the measured signal associated with a given component (such as DAPI, FITC,
etc.).
Normalized for Exposure reports the number of counts in the image, after dividing by a factor that
accounts for all the acquisition settings in use (gain, binning, bit-depth, and exposure time). Using
Counts Normalized for Exposure allows you to compare images taken using different camera settings
or exposures, with the assurance that signal levels indicate the actual brightness at the sample,
regardless of the instrument settings.
Counts Normalized for Exposure = counts / {2bit depth x exposure time x gain x binning
area}, where bit depth is the bit depth of the imagery, typically 8-bit (256 levels of gray) or 12-bit,
exposure time is in seconds, gain is the gain setting of the camera, and binning area is 1 for 1x1, 4
for 2x2, etc.
The values are small when using Mean weighting, and it may be hard to develop an intuition about
what is normal. Selecting Total weighting (default) produces larger values.
For brightfield images that are converted to Optical Density, inForm produces unmixed component
signals in OD (Optical Density) units. Optical Density indicates the amount of absorbing material
present at a location. Optical Density = -log10 (pixel value / white reference pixel value).

Weighting
Specifies whether to use the Mean, Peak, or Total signal to calculate the displayed units.
Total: The sum of all signals of the selected component across all wavelengths. Available for all images
except images converted to Optical Density. (Default for fluorescence images.)
Mean: The average of all signals of the selected component across all wavelengths. Available for all
units except Counts for Monochrome images. This is the equivalent of the settings in versions of inForm
prior to V2.0.2. Examples: For RGB color images, inForm reports the average signal across the three
color planes (red, green, and blue). A pure blue pixel with 240 counts would have a component strength
of 80 (= 240 counts / 3 planes). For multispectral images, the signal is averaged across all wavelengths
measured. So a pixel having a DAB signal of OD = 0.60 in the blue, OD = 0.20 in the green, and OD of
0.10 in the red would report a signal of 0.30 OD units (= [0.60 + 0.20 + 0.10] summed OD / 3 planes).
Peak: The peak signal of the selected component across all wavelengths. Available for images
converted to Optical Density and for fluorescent multispectral images. (Default for brightfield images.)
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Weighting Example
The simplified example below explains the difference between the three weighting options. (The example
uses only two fluors and ignores noise and other sources of error.)
This example uses a spectral library with just two elements, Fluor A and Fluor B, and eight wavelengths
(420, 460, 500, 540, 580, 620, 660, 700). The spectral library is shown in the figure below.

Figure 15. Spectral Lib rary Example

If an image pixel expresses one part Fluor A and three parts Fluor B, the signal at the pixel is shown in
the figure below.

Figure 16. Signal at a Pixel

Unmixing recovers the original spectra, scaled according to the measured expression at the pixel as
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shown in the figure below.

Figure 17. Original Spectra, Scaled

The challenge for the unmixed component image is to represent the unmixed spectrum using a single
value. The three weighting options correspond to three possibilities for how to do this.
Peak weighting represents the spectrum as the signal level at the brightest wavelength of the
spectrum. In the example, this gives component values of
Fluor A = 0.5739
Fluor B = 1.5216
Total weighting represents the spectrum as the sum of the signals at all wavelengths. In the
example, this gives component values of
Fluor A = 2.551
Fluor B = 7.7514
Mean weighting represents the spectrum as the average signal across wavelengths. In the
example, this gives component values of
Fluor A = 0.3189
Fluor B = 0.9689
Notice that Total weighting is the Mean weighting multiplied by the number of wavelengths (eight in this
example).
The figure below shows scaled spectra annotated with the weighting values:
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Figure 18. Weighting Values

8.5

Completing the Prepare Images Step
After all of the desired settings have been selected in the Image Preparation Settings panel, process the
images using any of the methods below and then advance to the next step in the project.
Click the Prepare Image button to apply the selected settings to the currently selected image.
Click the Prepare All button to apply the selected settings to all images open in the project.
Click the Advance button to apply the selected settings to all images open in the project and then
display the next step in the project.
Click the next step in the project in the Step Bar 14 at the top of the inForm window. All images are
processed using the current settings, and then the settings panel for the next step displays.
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9

Manual Tissue Segmentation
The topics in this section describe how to manually draw tissue categories on an image. The tissue
categories can then be used to generate data or can be used during the Cell Segmentation, Scoring, or
Object Counting steps. Algorithms that include a Manual Classification step cannot be used in Batch
processing.

9.1

Creating Tissue Categories
Tissue categories divide the image into specific areas that correspond to specific types of tissue (for
example, cancer, necrosis, stroma, etc.) or occasionally other structures of interest. The Manual
Classification step (available in inForm Basic Analysis or higher) enables you to draw the appropriate
tissue categories over areas of each tissue type on the images. Cell segmentation, scoring, and object
counting can all be restricted to a specific tissue category.
1. Click the Manual Classification step to display the Tissue Segmentation panel.
2. Click the New button under the Tissue Categories section to create a new tissue category.

3. To change the tissue category name, highlight the name and then type the desired name for the
tissue category.
4. To change the display color for the tissue category, click the Color pull-down and select the
desired color.
5. Repeat steps 2 through 4 to create all of the desired tissue categories.
6. See Drawing Tissue Category Regions

9.2
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Drawing Tissue Category Regions
Draw tissue categories around the areas on the image that contain each defined tissue type. A single
area on the image cannot belong to more than one tissue category.
To draw tissue category regions on an image:
1. Click the Draw option button next to the desired tissue category.
2. Click and drag to outline the desired area on the image.
3. If the region intersects another region in the same tissue category, the two regions are merged
into one region.
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4. If the new region intersects a region in a different tissue category, the area becomes part of the
new tissue category.
5. The unselected parts of the image file are covered with a gray mask. This may make it difficult
to see the image to select additional tissue categories. To temporarily hide the tissue
categories and the gray mask, click the Show/Hide Tissue Segmentation Map button.

After the next tissue category is drawn on the image, the tissue segmentation map displays
again.
6. See Editing Tissue Category Regions
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if necessary.

7. When all of the desired tissue categories have been drawn, continue with the next processing
step in the project. Either click the Advance button or click the next step button.

9.3

Editing Tissue Category Regions
After tissue categories have been drawn on an image, you can edit the regions to add areas to a region,
remove areas from a region, or remove individual pixels from a region.
To add an area to manually selected tissue categories:
1.

Zoom in or out on the image to the desired magnification.

2. Click the option button next to the tissue category that you want to add an area to.
3. If desired, use the Tissue Segmentation Map button to show or hide the tissue masks. Hiding
the tissue masks makes it easier to see the colors on the original image.

4. If Processing Regions have been defined, use the Process Regions button to show or hide the
process region masks.

5. Click and drag to outline the area to be included, intersecting the defined tissue classification
areas as desired.
6. Release the mouse button to connect the end point to the start point. The outlined area is
assigned to the specified tissue category.
To remove an area from the tissue category:
1. Click the Select Regions to Unclassify button.

2. Click and drag to enclose the area from which you want to remove the tissue classification.
3. Release the mouse button to connect the end point to the start point. The outlined area is
removed from the tissue category.
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To remove single pixels from the tissue category:
1. Zoom in on the image.
2. Click the Select Pixels to Unclassify button.

3. Click on a single pixel to remove it from the tissue classification region.
4. Click and drag to remove a line of pixels from the tissue classification region.
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10 Trainable Tissue Segmentation
The topics in this section describe how to automatically classify tissue using the tissue segmenter. To
set up the tissue segmenter, add tissue categories and draw training regions on images in the training
set, train the tissue segmenter, segment images, and then fine tune the segmenter based on initial
results.

10.1 Adding Tissue Categories
Tissue categories divide the image into specific areas that correspond to specific types of tissue (for
example, cancer, necrosis, stroma, etc.) or occasionally other structures of interest. The Segment
Tissue step (only available in inForm Tissue Finder) enables you to draw training regions around
representative areas of tissue on images and then train the tissue segmenter to automatically locate
similar regions of tissue in each image.
The Tissue Segmentation Training panel is used to define tissue categories, train segmenters, and
segment images in the image processing set.

Creating Categories
1. Click the Segment Tissue step to display the
Tissue Segmentation Training panel.
2. Decide how many tissue categories you want to
segment the images into.
3. Click the New button and type the desired name of
the tissue category in the text box.
4. Create the desired number of tissue categories for
the images in the project.
5. To change the display color for a tissue category,
click the Color pull-down and select the desired
color.

Figure 19. Creating Tissue Categories

Deleting Categories
To remove a category, click the category’s radio button and click the Remove button.
To clear all tissue categories and start over, click the Clear button.
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10.2 Drawing Training Regions
Training regions teach the tissue segmenter which cells should be included in each tissue category. It is
important that you already know what to look for and are able to visually recognize structures
characteristic of the tissue category. For example, if there are tumor cells present in any image that are
negative (i.e., not stained), be sure to include those also. It is important to train on the full range of
appearances of the tissue category, as in the example, where negatively-stained as well as the
positively-stained cells are included.
To draw the training regions:
1. In the Tissue Segmentation Training panel, click the Draw radio button for a tissue category.
2. Click and drag to draw regions around groups of cells. (For example, if the tissue category is
named Tumor, draw regions around groups of tumor cells).

Figure 20. Drawing Training Regions

3. To delete a region, either click the Delete Region button and click inside the region to be
deleted, or right-click on the region and select Delete Region from the pop-up menu. (This
menu also lets you delete all training regions or all within a selected category.)
4. When you are finished drawing regions for the first category, switch to the next category (e.g.,
non-tumor regions) and draw regions around cells characteristic of the next tissue category. Be
sure to capture visual anomalies such as areas slightly out of focus, folds, bubbles, etc. Also
capture stroma regions that have differing qualities of shape or orientation.
5. Repeat this process for all of the images in the training set.
6. When all training regions have been drawn, see Training the Tissue Segmenter
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10.3 Training the Tissue Segmenter
Only images that are included in the Training set are used to train the tissue segmenter. Images that
have been removed from the training set are not used to train the tissue segmenter, even if the images
include training regions.

Selecting Components for Training
Select the components that you want to use for training the
tissue segmenter.
Components that provide distinguishing pattern information that
is independent of signals to be quantified are preferred. For
example, the counterstain component plane (e.g., DAPI or
Hematoxylin) should be tried first for training because the
counterstain reveals the structure of the tissue, and is less
likely to produce a segmenter biased by the presence of the
molecular marker you are trying to quantify. For example, if
measuring the positivity of cells stained with Alexa Fluor® in a
sample stained with both DAB and Alexa Fluor, you would not
want the segmenter to be dependent on the Alexa stain
because that would bias the outcome.

Figure 21. Components for
Training

On the other hand, sometimes in brightfield applications where the presence of an IHC stain such as
DAB blocks the staining of the counterstain, using both the counterstain and the IHC stain
component planes for training yields a more robust tissue segmenter, even for the negative cases. In
these cases where the target label is included in the training, it is important to include abundant
negative cases in the training set.
Also, you should generally avoid using components that provide information unrelated to the desired
segmentation.

Selecting a Pattern Scale
The recommended approach is to start with the default Large pattern scale. Once you have drawn
training regions and trained a tissue segmenter, if segmentation accuracy for the training regions is
low (<85%), increasing Pattern Scale may improve accuracy. However, the pattern scale needs to
be compatible with the size of the training regions. Pattern scale refers to the spatial extent of
patterns that are measured to support machine learning and image analysis.
If the selected pattern scale (e.g., Maximum) is too large for the drawn training regions, a grey mask
displays on training regions that are too small after training and those training regions are not used
to train the tissue segmenter.
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You should use as large a pattern scale as is compatible with the training regions that you draw. If
most of the training regions have gray masks over them after training, reduce the pattern scale
(.e.g., from Large to Medium), and then retrain.
For example, if analyzing tumors in tissue sections in a 20x magnification image, the architecture is
fundamentally on a large scale, and you probably want to select Large. For items with inherently fine
scale structures, select Small or Medium. An understanding of the different scales can be learned
by seeing what size training regions are masked with grey after training.

Train the Segmenter
Click the Train Tissue Segmenter button to begin training the segmenter. The training process
may take some time, so be patient.
The percent accuracy of the new tissue segmenter displays. If, for example, the segmenter was
99% accurate, this would mean that if the new segmenter was to be applied to all of the images
used in training the segmenter, it would classify the pixels in the training regions with 99%
accuracy. (Fewer than 1% of the pixels in all the drawn regions would be misclassified.)
The software continues to try to improve the accuracy. Click the Stop button to stop training when
an acceptable level of accuracy is reached or the accuracy has stabilized. In general, segmenters
should be at least 80% accurate. If the accuracy reaches 100%, a Done button displays to close
the Algorithm Training dialog.

Recent Trainings
The Recent Trainings box records a history of segmenters trained using the current segmentation
settings. For example, the first time you train is named “Attempt 1,” the second training is named
“Attempt 2,” and so on. To re-classify the images using a previous segmenter, select the desired
training attempt (i.e., segmenter) from this drop down box. If you change any settings, the history of
segmenters is cleared.

Segmentation Resolution
The Segmentation Resolution determines the resolution of the tissue category segmentation.
There is a trade-off between resolution and segmentation speed, with an approximately 4x increase
in segmentation speed for every step in resolution reduction. Select Coarse if you want to segment
the images more quickly. Although the edges of the segmented regions appear pixelated, the
segmenter still accurately differentiates structures well (e.g., tumor from stroma). Select Fine if the
segmented regions need to have smoother edges, such as images for use in publications.
Segmenting with Fine resolution takes longer than with Coarse resolution. Also, if you selected a
small Pattern Scale, the Resolution must be set to Medium or finer.
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Segmenting the Tissue in the Training Images
Once you have trained the segmenter, you can segment the tissue in the current image or all of the
images in the training set. You can segment just the current image first, to test the tissue
segmenter. Then make any desired adjustments to the training parameters and retrain the
segmenter. To see the Tissue Category mask on all images, click the Segment All button. When
you are ready, advance to the next step in the project.

Fine Tuning the Segmenter
Observe the training regions following segmenter training. As mentioned above, if the software grays
out any region, this indicates that the region is too small for the selected Pattern Scale and was
not used to train the tissue segmenter. You can ignore this if segmentation performance is
adequate, delete the region and redraw a larger one, or try selecting a smaller pattern scale.
The Trim Edges option can be used to "erode" a tissue segmentation by removing the specified
number of pixels from the periphery of the selected tissue category, making it smaller. This is useful
if the tissue segmenter has a tendency to include pixels extending beyond the edges of objects or
tissue categories of interest (e.g., tumor or vessels). For example, if you notice cancer regions
extending into non-cancerous areas, select the Trim Edges option, choose the cancer tissue
category, and enter the number of pixels you want to trim from the borders of the cancer regions.
The Minimum Segment Size option is an adjustable parameter (in pixels) that removes segments
that have fewer pixels than this value. The removed segment is replaced by the tissue segment that
is most abundant around the segment that was removed.
If the Discard if Touching Image Border check box is selected, tissue regions touching the edge
of the image or process region are discarded. If not selected, all tissue regions are included.

10.4 Adding Images to the Training Set
When selecting images for the training set, it is recommended that you start with one image per distinct
appearance. The training set should represent the range of staining levels and tissue architectures that
you want to train the tissue segmenter to identify.
Whenever you draw a training region on an image (see Drawing Training Regions 48 ), inForm
automatically adds the image to the training set. You can also add or remove images from the training
set manually as described below.
1. Click the Image List Editor button to open the Available Images Window

21

.

2. Select the Training Set check box next to the images to add the image to the Training set.
3. Clear the Training Set check box next to an image to remove the image from the Training set.
4. Close the Available Images window.
5. When you switch to Single mode, a small blue square on each thumbnail image at the bottom
of the screen (see figure) indicates images are included in the training set. A green square
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indicates that the image is in the processing set.

Figure 22. Training Set and Processing Set Indicators

6. See Drawing Training Regions
set.

48

to add training regions to the desired images in the training

10.5 Editing Masks and Re-Training
After reviewing the segmented images, you might discover that some structures were not segmented
correctly, or the segmenter may have selected some unwanted regions. The Tissue Segmentation
masks should accurately cover their respective tissue categories.
To correct the tissue masks, you can either edit the mask manually, or you can re-train the tissue
segmenter to detect the desired regions.

Manually Editing the Tissue Segmentation Mask
If the experiment or study involves few enough images, you can manually edit the Tissue Segmentation
mask. Manual editing does not change the tissue segmenter and if the images are re-segmented, the
changes to the Tissue Segmentation masks are lost.
To manually add areas to a Tissue Segmentation mask:
1. Click the Edit Tissue Segmentation button on the
toolbar.
2. From the drop-down list, select the tissue segmentation
mask that you want to edit.
3. Draw around the areas on the image that you want to
include in the selected Tissue Segmentation mask.
4. To continue processing the images using the edited
Tissue Segmentation masks, advance to the next step
without re-segmenting the images.
5. If the project contains a cell segmentation step and cell
segmentation was performed before the mask was edited
(see Segmenting Cells 59 ), you should click the
Segment Images button in the Cell Segmentation
editor to re-segment the cells in the edited tissue
segmentations.
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Figure 23. Editing Tissue
Segmentation Masks

Re-Training the Tissue Segmenter
If some areas of the image were not classified as the desired tissue type, you can re-draw the training
regions around the areas that were incorrectly classified and re-train the Tissue Segmenter.
To re-train the tissue segmenter:
1. In the Tissue Segmentation Training panel, click the Draw radio button for the tissue category
that you want to draw additional training regions for.
2. Draw training regions around areas that were incorrectly classified.
3. Re-train the tissue segmenter and then re-segment the image. Verify that the desired regions
are now correctly classified in the desired Tissue Segmentation mask.
4. To see the tissue segmentation on all images, segment all images. (Note that re-segmenting an
image after retraining the tissue segmenter deletes any manual edits to the Tissue
Segmentation mask.)

10.6 Completing the Automated Tissue Segmentation Step
After all of the desired settings have been selected in the Tissue Segmentation Training panel and the
Tissue Segmenter has been trained, process the images using any of the methods below and then
advance to the next step in the project.
Click the Segment Image button to segment the currently selected image.
Click the Segment All button to segment all images open in the project.
Click the Advance button to display the next step in the project. (The tissue is segmented the next
time images are processed.)
Click the next step in the project in the Step Bar 14 at the top of the inForm window. The settings
panel for the next step displays. (The tissue is segmented the next time images are processed.)
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11 Threshold
Use the Threshold step to set threshold values for any of the unmixed components in an image and then
to view the regions on the image that are above the threshold. Statistics are calculated for the
thresholded regions and are displayed in the Quant Data table.
To set the thresholds and calculate the threshold statistics for the images:
1. Click the Threshold button in the step bar.

2. In the Components to Threshold list, select each of the image components you want to create
a threshold map for.
3. Click the Auto button to calculate a preliminary value for the Threshold Max and to choose a
preliminary Threshold value. The Threshold Max is set to the value of the brightest pixel in the
component. The slider range is set to (0 - Threshold Max). The threshold is set to an optimal
value, based on the component values. (The threshold max and threshold can be set manually
without clicking the Auto button, if desired.)
4. Set the desired Threshold for each unmixed component. Move the slider, type the desired value
or click the up and down arrow buttons to select the threshold. The image display shows the
areas that are above the threshold value as the slider is adjusted.
5. To change the color displayed for the regions, click the Color button and select the desired
color.
6. To change the minimum size of the thresholded regions:
Click the More button under the name of the Threshold map that you want to change.
Set the desired value for Minimum Connected Pixels by either clicking the Up or Down
arrow buttons or typing the value in the text box. The Minimum Connected Pixels specifies a
minimum region size based on the number of pixels. Only regions that are larger than the
Minimum Connected Pixels value are considered. Regions with fewer than this number of
pixels are ignored.
7. If there are multiple images in the project, either select each image and apply the current
settings to the image by clicking the Accept for Image button or click the Accept for All
button to apply the Threshold settings to all of the images in the project. Verify that the
threshold settings are appropriate for all images in the project and adjust if necessary.
8. If desired, change the threshold map view
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or edit the threshold maps
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9. To view the statistics for the generated regions in the Quant data table, see Viewing the Quant
Data Table 86 , or to export the data, see Exporting the Data 89 .
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Changing the Threshold Map View
The threshold maps for each component are stacked in layers on top of the original graphic, with the top
component in the Simple Threshold Settings panel as the uppermost layer in the image display. You
can change the order of the threshold maps or hide threshold maps.
1. To hide a threshold map, clear the Visible check box under the component that you want to
hide.

2. To move a threshold map up or down in the stack of maps, click the Up or Down arrows on
the left of the Color button.

Threshold

55

Editing Threshold Maps
Threshold maps can be edited manually. Additional areas can be drawn onto the threshold map or
undesired areas can be erased from the threshold map. This procedure describes how to use the editing
tools on the Simple Threshold Settings panel. The Add Thresholded Regions and Erase Thresholded
Regions buttons on the toolbar can also be used.
1. To view editing options, click the More button under the name of the Threshold map that you
want to edit.
2. To draw additional threshold regions, click the Add button under the component name and draw
the desired regions on the threshold map.
3. To remove threshold regions, click the Erase button and draw around the area to be removed.
Only the threshold areas for the selected component are erased.
4. To clear all manual edits from a threshold mask, click the Clear button under the name of the
component. Only the manual edits on the threshold map for that component are cleared.
To clear all manual edits from all threshold maps:
1. Click the down arrow next to the Erase Threshold Regions button and click Clear Edits.

2. Click Yes in the Clear Mask Edits window.
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12 Colocalization
Colocalization is a pixel-based analysis used to find overlapping components in images based on
thresholds set for each component. Colocalization of multiple markers can be determined and displayed
both visually and statistically. It is designed for analyzing and quantitating molecular markers and can be
used to determine the amounts of colocalization of multiple markers.
1. Click the Colocalization button in the step bar.

2. Under Markers for Colocalization, select the
markers for which you want to see overlap
(colocalization) and positivity percentages.
3. Under Denominator (Counterstain), select the
marker(s) to use as the counterstains. To see
colocalization of markers throughout the entire
image and not just within a particular
counterstain, select All Image Pixels.
4. For each component selected in the Markers or
Denominator, a Threshold settings area displays
below the Denominator check boxes.
5. To adjust the Threshold for each component:
a. Click the Auto button to calculate a
preliminary value for the Threshold Max and to
choose a preliminary Threshold value. The
Threshold Max is set to the value of the
brightest pixel in the component. The slider
range is set to (0 - Threshold Max). The
threshold is set to an optimal value, based on
the component values. (The threshold max
and threshold can be set manually without
clicking the Auto button, if desired.)

Figure 24. Colocalization Settings

b. Set the desired Threshold for each unmixed
component. Move the slider, type the desired
value, or click the up and down arrow buttons
to set the threshold. The image display shows
the areas that are above the threshold value
as the slider is adjusted.
c. To change the color of a threshold mask,
click the Color button and select the desired
color.

6. To view the threshold for each component, clear the Visible check box for all components
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except the component that you are adjusting. Clear the Visible check box for
Colocalization. Adjust the Threshold for the component until all of the desired areas are
marked as positive.
7. If there are small regions that are marked as positive that should not be included, or if
smaller regions should be marked as positive and are not, click the More button and adjust
the Minimum Connected Pixels value as desired.
8. Under Colocalization, click the Visible check box to show the colocalization map. If
desired, click the Color button and select the color to use to indicate areas of
colocalization.
9. To view the Colocalization statistics, see Viewing the Quant Data Table
Colocalization Data Table 84 .
10. To export the data, see Exporting the Data
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13 Segmenting Cells
Cell segmentation locates individual cellular or subcellular objects within an image field or within a
selected tissue category if tissue has been segmented. By first identifying the location of all cell nuclei,
inForm is able to identify cells and their associated cytoplasm and membrane. Once individual cells are
located, the set of pixels associated with each cell is identified so that marker signals can be extracted
for analysis and reporting.
Note:

Cells are considered to be an assembly of associated cellular components (nucleus,
cytoplasm, and membrane). If you are segmenting tissue, some cells may straddle two
segmented tissue regions. If a cell is not entirely contained within a single region, the
“containing region” is undefined, and the Region ID in the Data tables is #N/A (see
Displaying the Extracted Data 73 ).

The Segment Cells step is only available in inForm Cell Analysis and inForm Tissue Finder.
Use the Segment Cells panel to set parameters for segmenting cells into their respective categories so
that data can be extracted and analyzed on a per-cell basis.
To segment cells:
1. Select the desired cell components to segment: Nuclei, Cytoplasm, and Membrane. Cytoplasm
and Membrane can only be selected after Nuclei is selected.
2. Select Discard if Touching an Edge to discard any cell where any cell component touches
the edge of the image, process region, or tissue region, if applicable. Only the cells that are
entirely within the image, a process region, if applicable, and the selected tissue category, if
applicable, are included in the segmentation map. If not selected, cells are clipped at the edge
of the image or region. If a cell is clipped at the edge of a process region or tissue category
region, the size of the nucleus or cytoplasm inside the region may be smaller that the specified
Minimum Size.
3. If Nuclei is selected, click the Nuclei tab and select the desired parameters. See Segmenting
Nuclei 59 for descriptions of the parameters.
4. If Cytoplasm is selected, click the Cytoplasm tab and select the desired parameters. See
Segmenting Cytoplasm 63 for descriptions of the parameters.
5. If Membrane is selected, click the Membrane tab and select the desired parameters. See
Segmenting Membrane 64 for descriptions of the parameters.
6. Click the Segment Image button to segment the current image using the selected parameters.
7. If desired, change the parameters to obtain the desired results.
8. Click the Segment All button to segment all of the images.

13.1 Segmenting Nuclei
At the top of the Cell Segmentation Settings panel, select Nuclei in the Compartments to Segment
box. (You can also select Cytoplasm and Membrane if you intend to find those as well.) Click the
Nuclei tab.
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Selecting a Tissue Category
Select the Tissue Category in which to find the cell nuclei
or select All Categories to find cell nuclei in all tissue
categories. Cells that are outside the chosen category are
ignored. This option only displays if tissue has been
manually or automatically segmented.
Tissue categories of interest might be tumor regions in
oncology samples, and islet cells in pancreas samples.

Figure 25. Cell Segmentation Settings
for Nuclei

Selecting an Approach
Select the Pixel-Based (Threshold) approach when
there is a reliable nuclear counterstain, and nuclear pixels
can be found by applying a simple threshold. This
approach is purely pixel-based. This approach can also
be used for other image analysis needs that can be
satisfied with a simple threshold, such as detecting all
pixels within a tissue category that stain positive for an
IHC stain.
Select the Object-Based approach if the nuclear
counterstain does not provide consistent and specific
staining of nuclear objects, and more advanced
morphometry-based approaches are needed to detect
nuclei.

Figure 26. Cell Segmentation
Approach

Applying Signal Scaling
Auto Scale: Select Auto Scale if you want the software to
automatically scale each nuclear counterstain component
plane individually before performing nuclei segmentation. This
approach is a good place to start, and is useful if nuclear
counterstain signals vary widely. Auto Scale is often
sufficient for fluorescence applications.

Figure 27. Signal Scaling

Fixed Scale: If you need better nuclear segmentation performance, and counterstain signals are
consistent and reliable, you might get better results by selecting the Fixed Scale option. (The
units are in parentheses.) This requires entering a scaling value, which can be determined by
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choosing the View Component Data tool from the toolbar and "mousing around" on the brightest
nuclei to see the signal levels of the component being used for nuclear segmentation. Everything
in a nuclear segmentation (indicated by a green region) should be nuclei.
o Reduce the maximum OD or Counts value if nuclear segmentations are smaller than the
nuclei, or if no nuclear segmentations occur when the segmenter is finished.
o Increase the scale if segmentation is too sensitive and is finding many objects that are weakly
stained and not nuclei. Adjust the scale until the unwanted regions are not detected.

Selecting Components for Nuclear Segmentation
You can further add to what you consider nuclear pixels by
including other components in the underlying signal. Pick an
individual component signal as the primary, and then select
secondary and tertiary components if desired. Enter a
minimum signal value for each component. In Auto Scale
mode, the signal range for each component is 0 to 1. If you
selected the Fixed Scale option, the range for each
component is from 0 to 2 for OD images, 0 to 255 for 8-bit
images, and 0 to the Fixed Scale value for all other images.
Also, whenever you switch between auto scale and fixed
scale, the values are reset to zero.
Only pixels above the minimum signal value are counted as
nuclei. Using secondary and tertiary components is primarily
useful in brightfield IHC applications where nuclear IHC stains
are dark or "intense" and substantially block the Hematoxylin
counterstain. In these cases, performing nuclear
segmentation on the logical intersection of the Hematoxylin
and nuclear IHC signals is more effective. This approach
does not work if the dark IHC stains reside outside the
nucleus.

Figure 28. Components for Nuclear
Segmentation

Specifying a Nuclei Size Range
Set the Minimum Size. If too many small, unwanted
structures (e.g., not nuclei) are found during segmentation,
try increasing the minimum size value. Any nuclei that have
fewer pixels than this number are not segmented, and no
associated data is collected. If a nucleus is clipped at the
edge of a Process region or Tissue Category region, the
original size of the nucleus is used to determine if it meets
the minimum size threshold; the clipped size is reported in
the tables. For images taken at 20x magnification, 100 is a
good starting value.

Figure 29. Size Range

If appropriate, set the Maximum Size. This is required if you
intend to select the Refine Splitting clean-up option
discussed below. This sets an upper limit on nuclear
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segmentations (in number of pixels). Nuclear segmentations
larger than this number are ignored. This can be useful if you
want to ignore large clusters of nuclei, or if there are other
objects in the classified region of interest that are not nuclei.

Entering Nuclei Clean-up Settings
Select Fill Holes when some nuclei end up segmented with
“holes” in them. This results from a common effect in tissue
sections where nuclei appear hollow. Checking this check
box automatically fills holes in nuclei.
If you want only those nuclei holes that are smaller than a
certain size to be filled in, select Max. Hole Size (pixels)
and enter the maximum number of pixels. Nuclei with holes
that are larger than this value are not filled.
If you select Refine Splitting, nuclei that are touching each
other are split into separate nuclei instead of being detected
as one large nucleus. This option is available only if
Maximum Size is selected. Cell segmentation may take
considerably longer when using this function. If you do not
select Refine Splitting, nuclei that touch are detected as a
single nucleus.
Select Roundness: Minimum circularity to find only nuclei
that are more round. Zero returns any shape. Higher decimal
values (up to 1) restrict selections to more round objects
only.
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Figure 30. Clean-up options

13.2 Segmenting Cytoplasm
At the top of the Cell Segmentation Settings panel, select the Cytoplasm check box in the
Compartments to Segment box. (Note that you must segment the nuclei in addition to segmenting
cytoplasm. inForm only searches for cytoplasm where nuclei have been found.) Click the Cytoplasm
tab.

Selecting Cytoplasm Shape Parameters
Inner distance to nucleus: The distance (in pixels) from
the edge of nuclear segmentations to the inner edge of
the cytoplasm annular regions drawn around nuclei. This
buffer distance should be large enough to ensure that
imperfections in the nuclear segmentation do not lead to
signal from nuclei inadvertently becoming part of
cytoplasm signals.
Outer distance to nucleus: The distance (in pixels) from
the edge of the nuclear segmentation to the outer
boundary of cytoplasm segmentation. This distance
should be adjusted based on visual inspection of the
results, so that cytoplasm segmentation approximately
matches the average size of cells. This distance can be
set large enough to include membrane signals if desired.
In this case, it is important to note that the signal
extracted from the segmenter for cytoplasm is a mixture
of membrane and cytoplasm signal.

Figure 31. Cell Segmentation
Settings for Cytoplasm

Minimum Size: The minimum cytoplasm sample size (in pixels). If cytoplasm segmentations for
detected nuclei have fewer pixels than this number, those cells are excluded from the analysis.
This is common in cases where cells are tightly packed together without much space between
nuclei for cytoplasm areas to be segmented. If the cytoplasm is clipped at the edge of a Process
region or Tissue Category region, only the cytoplasm inside the region is used to determine the
size of the cytoplasm.
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Selecting Components to Include
You can further restrict what you consider “valid” cytoplasm
based on the underlying signal. You can pick an individual
component signal as the primary and then select secondary and
tertiary components if desired, and enter a signal range for each
one. Or select "Every Component" or “Any component” and
specify a signal range. Only pixels that fall within that signal
range are counted as cytoplasm. (The signal range varies based
on image type.)

Figure 32. Cytoplasm Pixel
Validation

13.3 Segmenting Membrane
At the top of the Cell Segmentation Settings panel, select the Membrane check box in the
Compartments to Segment box. (Note that you must segment the nuclei in addition to segmenting
membrane. inForm only searches for cytoplasm where nuclei have been found.) Click the Membrane
tab.

Selecting Components for Membrane Segmentation
1. Select the Primary component signal for membrane
segmentation.
2. Select the Secondary component if desired.
3. For each component, set the Full Scale:
Select an image that is typical of all of the images to
be analyzed.
Click the Auto button to find the brightest pixels in the
image for each of the selected components. The
brightest value for each component displays in the Full
Scale box for each component. (The units can be
counts or OD.)
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Figure 33. Components for
Nuclear Segmentation

Specifying the Segmentation Priority
The Segmentation Priority specifies which cell compartment
(Nucleus or Membrane) has higher priority when
segmenting a membrane that crosses a nucleus.
Figure 34. Segmentation Priority

Specifying a Maximum Cell Size
The Distance to Membrane value specifies the maximum
size of the cells, defined here as the distance (in pixels) from
the edge of the nucleus to the outer edge of the membrane.
A value of 12 for images taken at 20x magnification is usually
a good starting value. If the algorithm is finding a membrane
that is either too large or too small based on your knowledge
of the nucleus/cell size, then try reducing (or increasing) the
Distance to Membrane value. This value limits how far from
the nucleus the algorithm is permitted to go when
segmenting the cell membrane.

Figure 35. Maximum Cell Size
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14 Scoring IHC or IF
After segmenting nuclei, cytoplasm, and membrane, the detected cell compartments are quantified. The
options in the Score IHC or IF Settings panel provide functionality similar to that which is done
manually or visually when pathologists assess chromogenic immunohistochemical stain levels. The
Score IHC or IF settings specify the component thresholds and “score” the images.
1. Tissue Category: Select the tissue category to use
for scoring. Cells that are outside the chosen tissue
category are ignored. This option only displays if
tissue has been segmented. Only tissue categories
in which cells have been segmented are available.
2. Scoring Type: There are five Histogram score types,
which are used to assess the intensity of each label.
Select a score type from the Scoring box.
Descriptions of each method are given below.
3. Compartment: Select whether you want to score
the Nuclei, the Cytoplasm, or the Membrane cell
compartment. If desired, you can score the nuclei,
save the data, and then score the cytoplasm and/or
membrane separately. The scoring data is a result of
binning a histogram of all pixels within the selected
compartment.
4. Component: Select the component to use for
calculating scoring data.
Figure 36. Score IHC or IF Settings

5. Threshold Max: Click the Auto button to calculate the Threshold Max for the selected
component. The Threshold Max specifies the maximum value of the Threshold sliders. If
necessary, adjust this value up or down as needed. For OD converted images, 3.0 is the
maximum possible value.
6. Positivity Threshold: Specifies the threshold values for the selected Scoring Type. Drag the
slider, type the desired value in the text box, or click the up and down arrow buttons to change
the Positivity Threshold value. See Scoring Types 67 for descriptions of each Threshold.
7. Show Score Colors: If selected, the score colors display on the image and around the results
percentage text boxes. If not selected, the colors do not display on the image or around the
results percentage text boxes.
8. Change Color: Opens the Change Color window to select the colors for each bin or to restore
the default colors to the bins.
9. When you score the image(s), the results display at the bottom of the Score IHC or IF settings
panel. See Scoring Types 67 for descriptions of the results for each scoring type.
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Scoring Types
Positivity
This bins the spectrally unmixed nuclear, cytoplasm, or membrane signals into two bins, negative or
positive, with a single threshold. (See Figure 30 above.) It provides data in percent. Decreasing the
Positivity Threshold slider increases the percent positivity.
The Score Results (Percent) box shows the negativity and positivity percentages of the cell nuclei,
cytoplasm, or membrane.

Double Positivity (2x2-bin)
Select this scoring method to classify cells, according to
co-expression, into four classes: double negative, single
positive for one marker, single positive for another marker, or
double positive. The Negativity and Positivity percentages for
each of the two markers are also shown.
Double Positivity contains the same options as Positivity
with the addition of the following:
Second Marker Settings: Select the Compartment,
Component, Threshold Max, and Positivity Threshold for the
second marker after selecting the first marker settings.
Show Score Colors: Select the score colors to display on
the image: Double Positivity, First Marker, or Second
Marker.
To select the Double Positivity settings:
1. If the tissue has been manually or automatically
segmented, select the Tissue Category as described
above.
2. Select Double Positivity (2 x 2-bin) in the Scoring list
box.
3. Under First Marker Settings, select the Compartment
and Component, and then click the Auto button.
4. Under Second Marker Settings, select the
Compartment and Component, and then click the
Auto button.
5. To adjust the First Marker Threshold, select First
Marker in the Histogram Results box and then adjust
the First Marker Positivity slider or type the desired
value in the Positivity text box. Positive regions are
indicated by the Single Positive 1 color. Negative
regions are indicated by the Double Negative color.

Figure 37. Doub le Positivity Scoring

6. To adjust the Second Marker Threshold, select Second
Marker in the Histogram Results box and then adjust
the Second Marker Positivity slider or type the desired
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value in the Positivity text box. Positive regions are
indicated by the Single Positive 2 color. Negative
regions are indicated by the Double Negative color.
7. To view the double positivity colors, select Double
Positivity in the Histogram Results box.

0-3+ (4-bin)
This option bins spectrally unmixed signals in nuclei,
membrane or cytoplasm into four bins. This score type can
be used to calculate H-scores with nuclear stains.
0/1 Threshold: Specifies the value below which to include
cellular objects in the 0 to 1 bin.
1/2 Threshold: Cellular objects above the 0/1 threshold and
below the 1/2 threshold are included in the 1 to 2 bin.
2/3 Threshold: Cellular objects above the 1/2 threshold and
below the 2/3 threshold are included in the 2 to 3 bin.
Cellular objects above this value are included in the 3+ bin.
Score Results (Percent): Shows the percentage positivity
of the cell nuclei, membrane, or cytoplasm within each bin.
H-Score: The calculated H-Score of the image. The H-Score
is calculated using the percentages in each bin and ranges
from 0 to 300.

Figure 38. 0-3+ Scoring
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Ten-bin
This histogram bins the data into ten bins for more
quantitative work. The 10th Bin Nominal Level slider
specifies the ninth bin lower threshold. The other eight
thresholds are equally spaced between zero and the ninth
threshold.
The Histogram Results boxes display the percentages of
pixels falling into the bins determined by the nominal level
slider position.

Figure 39. 10-b in Scoring
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Fifty-bin
Divides signals into 50 equal bins.
The 50th Bin Nominal Level slider specifies the lower
threshold for the 50th bin. The remaining thresholds are
equally spaced between zero and the 50th bin threshold.
For display, the 50 values are summed into 10 values, each
value being the sum of 5 bins. The actual values for all 50
individual bins display in the Score table.

Figure 40. 50-b in Scoring
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15 Counting Objects
Count Objects locates individual irregularly-shaped objects within an image field or within a selected
tissue category if tissue has been segmented.
1. Click the Count Objects button in the step bar to display
the Object Counting Settings panel.

2. If tissue has been segmented, select the Tissue
Category in which you want to find the objects. Objects
outside of the selected tissue category are not counted.
(This option only displays if the project includes a Manual
Classification or Segment Tissue step.)
3. Select the desired Approach to use to identify objects:
Object-Based or Pixel-Based (Threshold). Select the
Pixel-Based (Threshold) approach when there is a
reliable or consistent stain, and object pixels can be
found by applying a simple threshold. This approach is
purely pixel-based. Select the Object-Based approach if
the stain does not provide consistent and specific staining
of objects, and more advanced morphometry-based
approaches are needed.
4. Select the desired Signal Scaling:
Auto Scale: Automatically scales each component
plane individually before performing object
segmentation.
Fixed Scale: If you need better segmentation
performance, and stain signals are consistent and
reliable, you might get better results by selecting the
Fixed Scale option.
5. Select the Primary component for object segmentation
from the drop-down list.
6. Adjust the Minimum Signal value for the primary
component to the desired threshold value.
7. If desired, select Secondary and Tertiary components
and minimum signal values.
8. To exclude objects smaller than a specific number of pixels, increase the value in the Minimum
Size (pixels) text box.
9. To exclude objects larger than a specific number of pixels, select the Maximum Size (pixels)
check box and specify the largest object size in pixels.
10. To automatically fill holes in objects, select Fill Holes. To limit the size of the holes that are
automatically filled, select the Max Hole Size check box and specify the size in pixels of the
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largest holes that should be filled.
11. To detect objects that touch other objects as individual objects, instead of as one object, select
the Refine Splitting check box. The Maximum Size (pixels) check box must be selected to
enable this option.
12. To exclude objects based on the roundness of the object, select the Roundness check box and
specify the desired Minimum Circularity. Zero returns any shape. Higher decimal values (up to
1) restrict selections to more round objects only.
13. To exclude any objects that are touching the edge of the image, process region, or tissue
region, select the Discard Object if Touching an Edge check box.
14. After processing, use the View Editor 73 to view the resulting data tables. You can also export
the Count Data table by advancing to the Export step (Exporting the Data 89 ).
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16 Displaying the Extracted Data
After analyzing the images, use the View Editor 19 to customize the view of the images and extracted
data. These options do not change the underlying images, they only change how the images are
displayed. The options below are available in the Data Displayed list (depending on which software
configuration is installed and which steps are included in the project):
Viewing the Color Image

73

Viewing the Component Image
Viewing the Composite Image

74
77

Viewing the Tissue Segmentation Data Table
Viewing the Cell Segmentation Data Table
Viewing the Score Data Table

78

80

82

Viewing the Colocalization Data Table
Viewing the Count Data Table

85

Viewing the Quant Data Table

86

84

16.1 Viewing the Color Image
Select Color Image in the Data Displayed list, then choose the desired options.
The following options are available for the Color Image:
Rendering Options
Brightness: Change the value to change the
brightness of the selected image. Lighten or darken
the image using the Brightness percentage slider.
Contrast: Change the value to change the contrast
between light and dark portions of the selected image.
Increase or decrease the contrast using the Contrast
percentage slider.
Use Enhanced Contrast: Select to artificially
increase the vividness of the image.
Use Equal RGB Color Weighting: (only for
Fluorescence images) Select to distribute the
wavelength range equally in the red, green, and blue
components. If not selected, the image displays as it
looks to the human eye.
Reset to Default button - Click to reset the
Rendering Options back to the default settings.
Image Options: See Image Options

Figure 41. View Editor (Color Image)
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16.2 Viewing the Component Image
Select a Component in the Data Displayed list, then choose the desired options.
The following options are available for the Component
Image:
Rendering Options
Show As:
Brightfield: Select to display the component
signal on a white background.
Fluorescence: Select to display the component
signal on a black background.
Component Color:
Black and White: Select to show the component as
a black and white image. The component signal color
is determined by the Brightfield/Fluorescence setting.
Color: Select to show the component in color. This
color is calculated from the spectral shape of the
component, i.e. the color you would see when viewed
through a microscope.
Scaling:
Scale Views for each Image Individually: Select
to show each image scaled individually. Dim images
are brightened to show the components. The relative
brightness of components cannot be compared
between images.
Scale Views Equally for All Images in the
Project: Select to show the brightness of
components for each image all scaled relative to each
other. Bright components appear bright and dim
components appear dim. All images are rescaled
relative to all images in the project whenever images
are removed from or added to the project.

Figure 42. View Editor (Color Image)

Scale Views Based on Selected Images: Select to show the brightness of components for each
image based on the brightness range of the selected images. Bright components appear bright and
dim components appear dim. The first time the option is selected, all current images in the project are
selected. The scaling limits remain the same even if images are added to or removed from the project.
Click the Reset button to open the Scaling Image Selection Window 76 to change the images
selected to determine the scaling limits. See Scaling based on Selected Images 75 for the suggested
workflow.
When this option is selected, the scaling limits are saved with the algorithm and project. If the
algorithm or project is used in Batch Mode, then all images processed in the batch job use the saved
scaling limits.
Brightness: Change the value to change the brightness of the selected image. Lighten or darken the
image using the Brightness percentage slider.
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Contrast: Change the value to change the contrast between light and dark portions of the selected
image. Increase or decrease the contrast using the Contrast percentage slider.
Reset to Default button - Click to reset the Rendering Options back to the default settings.
Image Options: See Image Options
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Scaling Based on Selected Images
Images with bright signals in each component, such as positive controls or positively expressing
images, should be used to scale all images in the project.
When using Scaling Views based on Selected Images, the workflow below is suggested to set the
desired scaling limits.
1. Load only the images of the positive controls for the images.
2. Process the images as desired.
3. Open the View Editor and select any component in the Data Displayed drop-down list.
4. Select the Scale Views Based on Selected Images option. The scaling limits are set based
on the positive control images that are open in the project.
5. Save the algorithm and/or the project.
6. Use the settings for batch processing by loading the algorithm or project in the Batch tab.
7. If the positive controls change, open the project and click the Reset button on the View Editor.
Select the new positive controls in the Scaling Image Selection window 76 to set the new
scaling limits.
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Scaling Image Selection Window
Use the Scaling Image Selection Window to
choose the images used to scale the
brightness of all images in the project. The
images that are brightest in at least one
component are at the top of the list and are
selected by default. Images must be
unmixed to be used for the scaling
calculations. If an image is not unmixed, it
displays at the bottom of the list and the
Select For Scaling check box is disabled.
Select For Scaling Check boxes: The
scaling limits are calculated using all
selected images. These scaling limits are
saved and used when processing images in
Batch Mode.
Use the Thumbnail and Image Name
columns to identify the images in the project.
The Image Name column also identifies
images that are the brightest for each
component.
Cancel button: Closes the Scaling Image
Selection Window without recalculating any
image scaling limits. The limits do not
change.
Done button: Recalculates the image
scaling limits using the selected images and
then closes the window.

76

inForm - User Help

Figure 43. View Editor (Color Image)

16.3 Viewing the Composite Image
Select Composite Image in the Data Displayed list, then choose the desired options.
The following options are available for the Composite
Image:
Rendering Options
Show As:
Brightfield: Select to display the composite
image on a white background.
Fluorescence: Select to display the composite
image on a black background.
Scaling:
Scale Views for each Image Individually:
Select to show each image scaled individually.
Dim images are brightened to show the
components. The relative brightness of
components cannot be compared between
images.
Scale Views Equally for All Images in the
Project: Select to show the brightness of
components for each image all scaled relative to
each other. Bright components appear bright and
dim components appear dim. All images are
rescaled relative to all images in the project
whenever images are removed from or added to
the project.
Scale Views Based on Selected Images:
Select to show the brightness of components for
each image all scaled relative to the selected
images. Bright components appear bright and dim
components appear dim. The first time the option
is selected, all current images in the project are
selected. The scaling limits remain the same
even if images are added to or removed from the
project. Click the Reset button to open the
Scaling Image Selection Window 76 to change
the images selected to determine the scaling
limits.

Figure 44. View Editor (Composite Image)

Display Intensity: Select True to display each
component in the composite image at the original
intensity. For example, if Component A is dimmer
than Component B, they display that way in the
composite. Select Adjustable to display each
component in the composite image at the intensity
selected on the slider.
Display Color: Select True Color to display each
Displaying the Extracted Data
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component in the calculated color from the spectral
shape of the component. Select False Color to
display each component in the selected false color.
Select the False Color using the color picker next to
each component (only visible when False Color is
selected).
Component check boxes: Select to display each
component. If not selected, the component does not
display. (The Intensity Slider for each component only
displays if the Display Intensity is Adjustable. The
Color Selector for each component only displays if the
Display Color is False Color.)
Reset to Default button - Click to reset the
Rendering Options back to the default settings.
Image Options: See Image Options
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16.4 Viewing the Tissue Segmentation Data Table
The Tissue Segmentation Data Table is available when an algorithm contains a manual tissue
segmentation or trainable tissue segmentation step. The table provides information on the manually or
automatically segmented tissue regions. Select Tissue Segmentation Data in the Data Displayed list,
then choose the desired options under Table Contents. Each option you select adds one or more data
columns or rows to the table.
During image analysis, segmented tissue categories are assigned ID numbers. These numbers are used
in the data tables to identify the tissue category for stats such as area (pixels), area (percent), etc.
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The following options are available for the Tissue
Segmentation Data Table:
Components: Select all or individual components for
which to display component statistics. Each selected
component creates one column for each component stat
selected.
Tissue Categories: Select all or individual tissue
categories for which to display data. An entry row is
created for each Region ID in the tissue category.
Component Stats: Select the values to display for each
component signal. See Component Stats 87 for
descriptions of each option.
Position Stats: Select which values to display for each
segmented object. See Position Stats 87 for
descriptions of each option.
TMA Core Info: Select the options to include in the
data table. See TMA Core Info 87 for descriptions of
each option.
Shape Stats: Select the options to include in the data
table. See Shape Stats 88 for descriptions of each
option.

Figure 45. View Editor (Tissue Segmentation
Data)
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16.5 Viewing the Cell Segmentation Data Table
The Cell Segmentation Data Table is available when an algorithm contains a cell segmentation step. The
table provides information on the segmented cells. Select Cell Segmentation Data in the Data
Displayed list, then choose the desired options under Table Contents. Each option you select adds a
data column or row to the table.
Cells are assigned sequential ID numbers according to the location of nuclei within each tissue
category, if tissue has been segmented. ID numbering restarts at 1 in each tissue category. The table
only shows statistics for cell compartments that have been segmented (nuclei, cytoplasm, membrane).
For example, if cytoplasm is not segmented, the Cytoplasm column is not included in the table.
The following options are available for the Cell
Segmentation Data Table:
Components: Select all or individual components for
which to display component statistics. Each selected
component creates one column for each component stat
selected. If there is no data for a component, the
component will not be displayed in the list.
Tissue Categories: Select all or individual tissue
categories for which to display data. If selected, a
Tissue Category column displays in the Cell
Segmentation table to specify the Tissue Category for
each cell. This selection does not display if there is only
one Tissue Category defined or if there is no Segment
Tissue step in the project.
Component Stats: Select the values to display for each
component signal. See Component Stats 87 for
descriptions of each option. Each selection adds one
column for each segmented cell component and one
column for the entire cell.
Cell statistics are calculated over the entire
segmented area of the cell. Unsegmented areas
are not included.
The Entire Cell statistics are calculated using
only the cell components that are segmented.
(For example, if only nucleus and cytoplasm are
segmented, the Entire Cell statistics will not
include the membrane.)
TMA Core Info: Select the options to include in the
data table. See TMA Core Info 87 for descriptions of
each option.
Position Stats: Select which values to display for each
segmented object. See Position Stats 87 for
descriptions of each option.
Shape Stats: Select the options to include in the data
table. See Shape Stats 88 for descriptions of each
option.
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Figure 46. View Editor (Cell Segmentation
Data)

The columns below are always visible in the Cell Segmentation Data table:
Cell ID: Displays a unique ID number for each cell, based on the location of the nuclei within each
tissue category, if tissue has been segmented.
Total Cells: The total number of cells scored in the image.
Tissue Category Area (Pixels): If tissue has been segmented (either automated or manual), the area
of the selected tissue category, measured in number of pixels. If there is no tissue segmenting step,
this column is the total number of pixels in the whole image.
Cell Density (per megapixel): If tissue has been segmented (either automated or manual), displays
the cell density for each tissue category: the number of cells in the tissue category area / (the number
of pixels in the tissue category area / 1,000,000). If there is no tissue segmenting step, displays the
cell density for the entire image: Total cells / (the number of pixels in the image / 1,000,000).
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16.6 Viewing the Score Data Table
The Score Data Table is available when an algorithm contains a Score step. The available data changes
depending on the type of scoring. Select Score Data in the Data Displayed list, then choose the desired
options under Table Contents. Each option you select adds a data column to the table.
Table Contents: Select the options to include in the
data table. See TMA Core Info 87 for descriptions of
each option.
The columns below are always visible in the Score Data
table:
Tissue Category: If tissue has been segmented
(either automated or manual), the tissue category
used for scoring displays in the table. If there is no
tissue segmenting step, this column is blank.
Tissue Category Area (Percent): If tissue has been
segmented (either automated or manual), the area of
the selected tissue category displays in the table. If
there is no tissue segmenting step, this column is
100% (the whole image).
Number of cells: The number of cells scored in the
image.
(First) Cell Compartment: The cell compartment
used for scoring.
(First) Stain Component: The stain used to create
the threshold for scoring.

Figure 47. View Editor (Score Data)

The following additional columns are visible when Positivity (2-bin) scoring is selected:
Positivity: The scored positivity.
Positivity Threshold: The threshold value used to set the positivity.
The following additional columns are visible when Double Positivity (2x2) scoring is selected:
Second Cell Compartment: The secondary cell compartment used for scoring
Second Stain Component: The secondary stain used to create the threshold for scoring.
Double Negative: The percent of cells that is negative (less than the threshold) for both
components.
Single <Component1>: The percent of cells that is positive for component 1 and negative for
component 2.
Single <Component2>: The percent of cells that is positive for component 2 and negative for

82

inForm - User Help

component 1.
Double Positive: The percent of cells that is positive for both markers.
<Component1> Threshold: The threshold used for component 1.
<Component2> Threshold: The threshold used for component 2.
The following additional columns are visible when 0-3+ (4-bin) scoring is selected:
0+: The percentage of cells whose component strength is less than the first threshold.
1+: The percentage of cells whose component strength is greater than or equal to the 0/1+ threshold
and less than the 1/2+ threshold.
2+: The percentage of cells whose component strength is greater than or equal to the 1/2+ threshold
and less than the 2/3+ threshold.
3+: The percentage of cells whose component strength is greater than or equal to the 2/3+ threshold.
H-score: The calculated H-Score of the image. The H-Score is calculated using the percentages in
each bin and ranges from 0 to 300.
Threshold 0/1+: Clicking the Auto button sets this value to 1/4 of the Threshold max. This value can
be changed.
Threshold 1+/2+: Clicking the Auto button sets this value to 1/2 of the Threshold max. This value can
be changed.
Threshold 2+/3+: Clicking the Auto button sets this value to 3/4 of the Threshold max. This value can
be changed.
The following additional columns are visible when 10-bin or 50 bin scoring is selected:
Bin X (where X ranges from 1-10 or 1-50 per scoring type): Columns showing the percent of
scored values that fall in each scoring bin. The user sets the lower threshold for the last bin. The last
bin is the percent of cells whose component strength is greater than the threshold the user set. The
thresholds for the remaining bins are spaced evenly from 0. For example, the 49th bin has a lower limit
of (48 * threshold) / 49.
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16.7 Viewing the Colocalization Data Table
The Colocalization Data Tables are available when an algorithm contains a Colocalization step. Select
Colocalization Data in the Data Displayed list, then choose the desired options for each table.
The following tables are included in the
colocalization data:
Colocalization Table: Shows how much the
numerator components are colocated with the
denominator.
Percent Stats: Shows the percent
colocalization (where all colocalization
pixels are positive within the selected
denominator) and the percent positivity of
each selected component in colocalization.
Pixel Stats: Shows the actual pixel count
for the colocalization, component
positivities, and selected denominator.
In Channel Table: Shows the positivity of
one component within another for all selected
colocalization components.
Percent Stats: Shows the percentage of
inter-component positivity.
Pixel Stats: Shows the pixel count of the
component positivity.
Quant Table: Shows stats for the whole
image and colocalization region.
Components: Select all or individual
components for which to display component
statistics. One column per numerator
component is shown.
Component Stats: Select the values to
display for each component signal. See
Component Stats 87 for descriptions of each
option.
TMA Core Info: Select the options to include
in the data table. See TMA Core Info 87 for
descriptions of each option.
Position Stats: Select which values to
display for each segmented object. See
Position Stats 87 for descriptions of each
option.
Shape Stats: Select the options to include in
the data table. See Shape Stats 88 for
descriptions of each option.
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Figure 48. View Editor (Colocalization Data)

16.8 Viewing the Count Data Table
The Count Data Table is available when an algorithm contains an Object Segmentation step. Select
Count Data in the Data Displayed list, then choose the desired options under Table Contents. Each
option you select adds one or more data columns or rows to the table.
The following options are available for the Count Data
Table:
Components: Select all or individual components for
which to display component statistics. Each selected
component creates one column for each component stat
selected.
Tissue Categories: Select all or individual tissue
categories for which to display data. If selected, a
Tissue Category column displays in the Count Data table
to specify the Tissue Category for each cell. This
selection does not display if there is only one Tissue
Category defined or if there is no Segment Tissue step
in the project.
Component Stats: Select the values to display for each
component signal. See Component Stats 87 for
descriptions of each option.
TMA Core Info: Select the options to include in the
data table. See TMA Core Info 87 for descriptions of
each option.
Position Stats: Select which values to display for each
segmented object. See Position Stats 87 for
descriptions of each option.

Figure 49. View Editor (Count Data)

Shape Stats: Select the options to include in the data
table. See Shape Stats 88 for descriptions of each
option.
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16.9 Viewing the Quant Data Table
The Quant Data Table is available when an algorithm contains a Threshold or Colocalization step.
Select Quant Data in the Data Displayed list, then choose the desired options under Table Contents.
Each option you select adds one or more data columns or rows to the table.
The following options are available for the Quant Data
Table:
Components: Select all or individual components for
which to display component statistics. Each selected
component creates one column for each component stat
selected.
Component Stats: Select the values to display for each
component signal. See Component Stats 87 for
descriptions of each option.
TMA Core Info: Select the options to include in the
data table. See TMA Core Info 87 for descriptions of
each option.
Position Stats: Select which values to display for each
segmented object. See Position Stats 87 for
descriptions of each option.
Shape Stats: Select the options to include in the data
table. See Shape Stats 88 for descriptions of each
option.

Figure 50. View Editor (Quant Data)

16.10 Image Options
The Image Options below are available on the View Editor 19 when an image is selected in the Data
Displayed list. Select or clear the check boxes described below to show or hide maps or regions on all
images in the project. The buttons on the left side of the image display area also show or hide the maps
or regions. Show Score Colors is also accessible on the Score Settings panel. The Equalize Display
Histogram can only be shown or hidden here.
Tissue Segmentation Map - Select to display the Tissue Segmentation Map on the image. (Only
for projects that include a Manual Classification or Segment Tissue step.)
Nuclear Segmentation Map - Select to display the Nuclear Segmentation Map on the image.
(Only for projects that include a Segment Cells step.)
Cytoplasm Segmentation Map - Select to display the Cytoplasm Segmentation Map on the
image. (Only for projects that include a Segment Cells step.)
Membrane Segmentation Map - Select to display the Membrane Segmentation Map on the
image. (Only for projects that include a Segment Cells step.)
Show Score Colors - Select to display the Score Colors Map on the image. (Only for projects that
include a Score IHC or IF step.)
Object Segmentation Map - Select to display the Object Segmentation Map on the image. (Only
for projects that include a Count Objects step.)
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Training Regions - Select to display the Training Regions on the image. (Only for projects that
include a Segment Tissue step.)
Processing Regions - Select to display the Processing Regions on the image.
Equalize Display Histogram - Select to map the pixels so the image histogram has approximately
the same number of pixels assigned to each tonal value of the histogram. This gives the best
display of the whole dynamic range of dim and bright signals. If not selected, the lowest 0.01% of
the pixels are mapped to 0, the highest 0.01% are mapped to 255, and the remaining pixels are
linearly interpolated between those values. This prevents a few bright or saturated pixels from
skewing the display.
See Displaying the Extracted Data
data table.
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for descriptions of other options available for each image type or

16.11 Component Stats
The data tables contain the options below.
Min: Displays one column containing the minimum value of the component in the region and one
column displaying the .
Mean: Displays the mean of the component in the region. The summary line displays the
weighted mean value of the component across all regions, which is the average of the region
means, weighted by region size.
Max: Displays the maximum value of the component in the region.
Std Dev: Displays the standard deviation of the values for the component in the region. The
summary line displays the standard deviation of the individual means.
Total: Displays the sum of the value of the component across all pixels in the region.

16.12 TMA Core Info
The data tables contain the options below.
Show Core ID: If the image is of a core on a TMA slide scanned with a Vectra scanner, the
Sector, Row, Column and Field of the core display in the table. If there is no core information, the
columns contain zeros.
Show Slide Info: If the image was taken with a Vectra scanner, the Lab ID and Slide ID from the
file name display in the table. If there is no slide information, the columns are blank.

16.13 Position Stats
The data tables contain the options below. Units are in pixels.
X Position and Y Position: The X and Y location of the center of the bounding box for the region.
Process Region ID: If process regions are defined for the image, displays the ID number of the
process region containing the tissue category. Displays #N/A if an object spans multiple process
regions.
Distance from Process Region Edge (Pixels): The distance, in pixels, from the center of this
region's bounding box to the nearest edge of the containing process region. Displays #N/A if the
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distance cannot be determined.
Category Region ID: If tissue is segmented, displays the Region ID of the tissue category the
segmented object is in. (Only available in the Cell Segmentation and Count Data Tables if tissue
has been segmented.)
Distance from Tissue Category Edge (Pixels): The distance, in pixels, from the segmented
object to the nearest edge of the tissue category. Note that if the distance is reported as #N/A,
this indicates that the distance is unknown or indeterminate, for example if a cell is in a tissue
region that abuts the edge of the image. The cell may be closer to the edge of the image than to
any other region in the image, so it cannot be determined whether the distance to an in-image
point would be nearer than a point that lies beyond the edge of the image. (Only available in the
Cell Segmentation and Count Data Tables if tissue has been segmented.)

16.14 Shape Stats
The data tables contain the options below.
Area (pixels): The size, in pixels, of the region.
Area (percent): The region size as a percent of the total processed area. If there are no
processing regions, it is the total image area. Otherwise it is the total area of the processing
regions.
Compactness: The compactness of the region. Compactness is the ratio of the area of the region
to the area of a circle (the most compact shape) having the same perimeter. A circle has a
compactness of 1. Objects that are elongated or irregular are less compact, as are objects with
irregular or reticulated edges.
Minor Axis: The smaller of the two axes of the minimum area bounding box enclosing the region.
Major Axis: The larger of the two axes of the minimum area bounding box enclosing the region.
Axis Ratio: The ratio of the major axis / minor axis of the minimum area bounding box enclosing
the region.
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17 Exporting the Data
After analyzing the images, use the Export step to export images, component images, maps, and data
tables. Images are exported in the format selected in the Export Settings step. Data tables are exported
to tab-separated text files, which can be opened in Microsoft® Excel® and many other data analysis
programs.
1. Click the Export button to display the Export
Settings panel.

2. Click the Browse button to select or create the
desired Export Directory.
3. Select the Image Output Format you want to
export images to, either JPEG or TIFF. (Generally,
TIFFs retain more resolution and are usually larger.
JPEGs are compressed slightly and are often better
for emailing and publishing on the web.)
4. From the Images to Export list, select the images
and maps to export. Images can be exported with or
without the maps. Exporting the images with maps
can be used with Review/Merge to view the
segmentation for all images in a batch.
5. Select the Component Images (multi-image
TIFF) option to save a multi-image TIFF file of
component data for analysis using third party
analysis software. The values in the Component
images are in the units selected in the Prepare
Images step.
Components are saved in the spectral library order
and the components are listed in order in the
description tag of each of the component files in the
stack.

Figure 51. Export Settings

6. Select the desired Maps to Export. Maps are
exported alone, without the original image behind the
map.
Note that the Cell Segmentation Map is a 'label'
image that can be used in other image processing
tools. Label images are 16-bit gray-scale TIFF
images where all pixels from a segmented object
have the same unique gray-scale value, up to 65,000
objects.
7. Select the desired Tables to Export. The tables
available for export depend on which steps are
included in the algorithm or project. Data tables are
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exported to tab-separated text files, which can be
opened in Microsoft® Excel® and many other data
analysis programs.
8. In Table Fields to Export, select whether to export
all available table data fields, or only the fields that
are visible in the table view. To select which fields
are visible in the table, use the View Editor (see
Displaying the Extracted Data) 73 .
9. Select File Name Options: If files are already saved in the selected export directory, select
how to name the new files. You can:
- overwrite existing files if the new file names match, or
- rename the new exported files to preserve any existing files in the export directory.
10. If you want to replicate the directory structure of the source images to the export directory, enter
the number of directory levels to replicate in the Copy __ level(s) text box. For example, by
entering "2" in this field, data in a "CancerStudy\Sample001" directory would be exported to the
\<ExportDirectory>\CancerStudy\Sample001\ directory. This helps keep the exported images
organized.
11. Click Export For Selected or Export for All to export the data.
The figure below shows a sample list of exported files.

Figure 52. Exported Data Files
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18 Batch Processing
Batch Analysis processes a large number of images quickly and effectively, with just one click of the
batch Run button. Before beginning batch analysis, create and test an algorithm or project on a set of
images that is representative of the entire data set. Adjust the algorithm or project as necessary until the
images are processed as desired and then save the algorithm or project.

Figure 53. Batch Analysis Tab

1. Click the Batch Analysis tab to configure the batch settings and select images for processing.
You are prompted to save the open project. Click Yes to save the open project or No to close
without saving.
2. Algorithms that contain the Manual Classification step are not compatible with batch
processing. If the open project contains this step, the software will post a warning. Open a
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project that does not contain steps that require user interaction, and then click the Batch tab.
3. Select a Batch Algorithm or Project. When you first switch to the Batch panel, the
Algorithm settings are copied from the active project. You can run a batch using these
settings, or click the Browse button to select an Algorithm (.ifp) or Project (.ifr) file that contains
the desired settings. When loading a project, only the algorithm settings are used. The images
from the project are not loaded or processed.
4. If desired, select the Create separate directories for each item/image option to save the
exported files in a separate folder for each of the images or slides in the data set. This is
recommended for large batch processes that result in many data files and images.
5. Select the desired export settings to export images, component images, maps, and data tables.
Export settings are explained in detail in Exporting the Data 89 .
6. Click the Add Images button to select images to process or click the Add Slides button to
select single slides or folders containing multiple slides. A slide is a scan from the Vectra
software. If a slide has been reviewed with Vectra Review, the batch run only includes the
accepted fields. If the slide has not been reviewed, all fields are included in the batch run.
7. If necessary, use the Remove Selected button to remove selected images or slides from the
batch or use the Remove All button to remove all of the images or slides from the batch.
8. Click the Run button. inForm processes the items one at a time and exports the specified data.
9. When the image processing is complete, click the Done button in the Batch Progress window.
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19 Merging the Data
Use the Review/Merge tab to combine exported data files from multiple images or slides. Each type of
data file from a batch run can be merged into a single file. For example, all Cell Segmentation data files
can be merged into a single file that contains the Cell Segmentation data from all the images in the
batch.
1. After running a batch, click the Review/Merge Tab.
2. The Batch directory defaults to the directory of the
current batch process, or the last directory used for
batch processing. Click the Browse button to choose
a different directory of images/slides and data.
3. The data sets that can be merged display in the list.
All data sets are selected by default.
4. Review the list of data sets and select the data sets to
be reviewed:
Select or clear the check marks in the list to
include or exclude specific data sets.
Click the Include All button to select all data sets
in the list.
Click the Include None button to clear the check
boxes for all data sets in the list.
5. When a data set name is selected in the list,
thumbnails of the exported images for each data set
display at the bottom of the window. Click on a
thumbnail to view the image in the large image display
area.

Figure 54. Review/Merge Tab

6. Review the images and accept or reject each data set:
Use the left or right arrow buttons next to the
Gallery thumbnails to scroll through the exported
images for each data set.
Click the Yes button to include the data set or click
the No button to exclude the data set.
If desired, use the Merge hot keys listed on the
bottom left of the window to review the exported
images for each data set.
7. When all data sets have been reviewed, click the
Merge button. Type a file name prefix to identify the
new files as the merged files. The merged data files
are saved as tab separated text files in the batch
directory with the specified file name prefix followed by
the name of the data table. Data from any excluded
data sets are included in the <prefix>_rejected_...
files.
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20 Creating Algorithms for Vectra
Customers who have purchased PerkinElmer's Vectra Intelligent Slide Analysis System use inForm to
create Tissue Finder and High Powered Field (HPF) Finder algorithms for use with Vectra slide scanning
protocols. The Tissue Finder algorithm differentiates between tissue and non-tissue regions. The HPF
Finder algorithm finds specific targets such as tumor cells, inflammation, arterial plaque, etc. To fully
utilize the imaging and tissue classification capabilities of the Vectra system, both of these algorithms
need to be created for each unique set of tissue slides, and paired with their corresponding Vectra
protocols.

Selecting and Scanning a Slide Set for Algorithm Training
Before creating algorithms for a Vectra slide scanning protocol, use the Vectra Slide Analysis
System to scan some slides selected from the slide set. Select enough sample slides so that
heterogeneity of the entire slide set is represented in the sample slides. The sample slides can
contain up to 20 slides, and should contain examples of all of the tissue types the algorithms will
encounter when classifying images during the Vectra slide scanning protocol. You may want to
scan two sets of sample slides; the first set can be used to train the algorithm and the second set
can be used to test the algorithm.
In Vectra, load and scan the sample tissue slides manually, one at a time. Refer to the Vectra
User's Manual for detailed instructions.

Selecting Images for Algorithm Training
When you have finished scanning the sample slides, review the monochrome and color image data
sets, and select images for algorithm training and testing as follows:
1. Select from 3 to 10 monochrome images (from the "Monochrome\fullres" Vectra directory).
These images should contain examples of all of the tissue types that the algorithm will
encounter. Group images that have similar phenomena into pairs and divide each pair into two
separate folders. Images from one folder will be used for training the algorithm. Images from the
second folder will be used to test the new algorithm.
2. Review the color image data set and select from 3 to 10 color images (from the "LPF\fullres"
Vectra directory) representing all phenomena the algorithm might encounter. Again, group these
images into two folders of up to 20 images each.
3. You can now use inForm to create the Tissue Finder and HPF Finder algorithms.
Note:

While 3 to 10 images is usually sufficient, you may need more images to get a good
segmentation of the target class across all slides if the target has wide variation.

Creating Algorithms for Vectra
Create the Tissue Finder algorithm:
1. Choose File > New > Project. Choose the Vectra Tissue Finder option and click Create.
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Figure 55. Vectra Tissue Finder project

2. Choose File > Open > Image and select the first group of monochrome images.
3. Click Prepare All to prepare the images.
Important!

Do not perform a conversion of the images to optical density. Also, never change the
resolution of the images for Tissue Finder or HPF Finder projects. The algorithm will
not work with Vectra if the image resolution is changed.

4. Either click the Advance button at the bottom of the window or click the Segment Tissue
button.
5. In the Segment Tissue step, two tissue categories are automatically created: Target Tissue
and Other.
6. Draw training regions around tissue and around non-tissue regions on each of the images, using
the appropriate tissue categories (see Drawing Training Regions 48 ).
7. Set the Segmentation Options as necessary for the current images (see Training the Tissue
Segmenter 49 for instructions). In most cases, you can select Coarse for the Segmentation
Resolution. This allows the algorithm to classify images more quickly.
8. Click Train Tissue Segmenter to train the new Tissue Finder algorithm. When training is
finished, segment the current image. If the segmentation looks good, segment all of the images.
9. To test and verify the Tissue Finder algorithm:
a. Click the Available Images button to open the Available Images Window

21 .

b. Remove the first set of images from the processing set, but leave them in the training set.
c. Load and segment the second set of images using the same algorithm.
d. Click Segment All and examine the resulting tissue segmentation.
e. If the algorithm needs improving, draw additional training regions on the second set of
images. Click Train Tissue Segmenter again, and then segment all of the images again.

Creating Algorithms for Vectra
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10. When you are satisfied with the Tissue Finder algorithm, click
the Advance button or the Export button.
11. In the Export step, click the Browse button to select an export
directory for the segmented monochrome images. The
remaining export options are automatically selected and cannot
be changed.
12. Click Export for All to export the segmented monochrome
images to the specified directory.
13. Select File > Save > Algorithm to save the new Tissue Finder
algorithm in the Algorithms folder of the VectraData directory.
(Saving it here makes it easier to find the algorithm from the
Vectra software.) The file name should identify it as the Tissue
Finder algorithm for the specific set of tissue slides.

Figure 56. inForm Export
Settings

Create the HPF (High Power Field) Training algorithm:
1. Create a new project, selecting the Vectra HPF Finder option in the New Project Window

22 .

2. Open the first set of low power RGB color images (from the "LPF\fullres" Vectra directory).
3. In the Prepare Images step, specify the sample format (brightfield or fluorescence).
Important!

Do not perform a conversion of the images to optical density. Also, never change the
resolution of the images for Tissue Finder or HPF Finder projects. The algorithm will
not work with Vectra if the image resolution is changed.

4. In the Segment Tissue step, add the desired tissue categories, draw training regions, select the
Segmentation Options, and train the Tissue Segmenter. Each of these steps is explained in
detail in Trainable Tissue Segmentation 47 .
5. When you are satisfied with the HPF Finder algorithm, export the images.
6. Select File > Save > Algorithm to save the new HPF Finder algorithm in the Algorithms folder
of the VectraData directory. (Saving it here makes it easier to find the algorithm from the Vectra
software.) The file name should identify it as the HPF Finder algorithm for the specific set of
tissue slides.
7. The Tissue Finder and HPF Finder algorithms can now be selected in the Vectra tissue
protocol.
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21 Appendix A: Calculating Fractional Tissue
Area
Fractional tissue areas can be calculated from inForm data using an Excel PivotTable. Examples of this
type of calculation are:
Tumor load: tumor area / (tumor + stroma)
Lung fibrosis: fibrosis area / (normal lung + normal collagen + fibrosis)
Breast tissue lobular involution: acini area / (acini + inflammation + lobular stroma)
It is also possible to calculate tissue fractions where the numerator and denominator are different tissue
categories, such as:
Kappa/lambda ratio in lymphoid tissue: kappa tissue area / lambda tissue area
This calculation can be performed per image or per slide with inForm (V2.0.1 or higher) and Vectra.

Initial Setup
These instructions assume that you already have an inForm algorithm capable of automatically
segmenting the tissue categories of interest, and that you have processed several images using the
algorithm and merged the tissue segmentation tables into a single table.
To compute tissue fraction by slide, you must have a column in the data table for slide ID. inForm
includes this column for Vectra images.
The instructions in this section are for Excel 2010 and may need modification for other versions of
Excel.

Create a PivotTable to Compute Fractional Tissue Area
To create the PivotTable:
1. Start Excel and open the data file. In the Open dialog, select “Text Files” in the file type dropdown, then select the inForm data file. The file name should end with
“tissue_seg_data_summary.txt”.
2. In the Text Import Wizard, if you are using a file from inForm V1.4, change the value for “Start
import at row” to 3. This skips the first two rows. For inForm V2.0 or higher, leave the value at 1.
Click “Finish” to open the file.
3. In the Insert ribbon, click “PivotTable”. Leave the defaults: use the entire table and put the table
on a new worksheet. Click OK to create the PivotTable. A new, empty PivotTable opens. On the
right side, the PivotTable Field List shows all the fields in the source table.
4. Click the check box next to the name of the field to summarize by, usually Sample Name or
Slide ID. It could also be TMA row and column. The selected field is shown in the Row Labels
box and as a column in the pivot table.
5. In the PivotTable Field List, click the check box next to Tissue Category to add Tissue Category
to the Row Labels list.
6. Drag “Tissue Category” from Row Labels to Column Labels.
Appendix A: Calculating Fractional Tissue Area
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7. Some tissue categories in the data may not be used in the tissue fraction calculation, for
example a “Background” category. In this case, click the drop-down next to “Column Labels”
and de-select any categories that are not of interest.
8. In the PivotTable Field List, click the check box next to Area (pixel) to add Area (pixel) to the
Values box.
9. You should now have a PivotTable that shows total pixel area for each tissue category of
interest and a Grand Total. The table has one row for each Sample Name or Slide ID, depending
on the selection for Row Labels.
10. To display pixel area as a percent, right-click on “Grand Total” and select “Value Field Settings”.
Select the tab “Show Values As”. In the drop-down, select “% of Row Total” and click “OK”.
You should now have a pivot table that displays percent of total area for each tissue category. The
values of interest can be read directly from the table. For example, a “tumor” category displays the
tumor load.

Compute a Ratio
The PivotTable does not easily display a ratio of two categories; it only shows each category as a
fraction of the total. Additional ratios can be added as new computed columns outside the pivot
table. Use explicit row/column identifiers in the formula, such as “D3”. Don’t use the
GETPIVOTDATA () function that Excel provides if you click on target cells. For example:
1. Click on the cell in the first empty column in the first data row.
2. Type the desired formula such as “=C5/B5” and press Enter.
3. Select the entire range in the target column, starting with the cell just entered.
4. Type CTRL+D to fill the column range with the desired formula.

Saving the Table
You can save the entire Excel workbook and/or export the PivotTable data as a text file for further
processing with other programs. If exporting the PivotTable, you may want to refine the table for
cleaner output. Below are some suggestions.

Remove the Grand Total Row at the Bottom
1. Open PivotTable Options by clicking the “Options” button at the left of the PivotTable Tools /
Options ribbon.
2. In the Totals & Filters tab, deselect “Show grand totals for columns”.

Display Fractional Area
To display the tissue fraction as a decimal fraction rather than as a percent, click the drop-down
next to the field name in the Values box. Select “Value Field Settings”. In the dialog box click
“Number Format” and set the desired formatting.
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Save as Tab-Separated Values
To save the file as tab-separated text:
1. In the File ribbon, choose Save As.
2. Select Text (Tab delimited) in the Save as type drop-down list. To save as a CSV file, select
CSV (Comma delimited).
3. Type the desired file name, select the desired location, and click Save.
4. Two warning messages display. First, “The selected file type does not support workbooks that
contain multiple sheets.” Click “OK”. Then, “[FileName] may contain features that are not
compatible with Text (Tab delimited).” Click “Yes”.
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22 Software EULA
The follow ing is an agreement (the "Agreement") betw een you and Cambridge Research & Instrumentation Inc., 68 Elm St.,
Hopkinton, MA 01748 ("CRI") for softw are know n as inForm and its accompanying documentation (collectively, the
"Softw are"). By installing and/or using the Softw are, you agree to the follow ing terms and conditions. If you do not agree to
all of the terms and conditions in this Agreement, you may not install or use the Softw are.

1. Single Use License. The Softw are is licensed to you and not sold. Subject to the terms and conditions of this
Agreement, CRI hereby grants to you a restricted, non-exclusive, non-transferable, non-assignable, non-sublicensable
and revocable license to use, for your internal purposes only, the executable code version of the Softw are and the
accompanying documentation in hard copy or electronic format. CRI RESERVES ALL RIGHTS NOT EXPRESSLY GRANTED
BY THIS AGREEMENT.
2. Specific Restrictions. You may use the Softw are only on a single computer. You may make only one (1) copy of the
Softw are, solely for backup purposes. You agree that, except as expressly permitted by applicable law , neither you nor
a third party acting on your behalf w ill: (i) decompile, disassemble or reverse engineer the Softw are; (ii) modify or create
derivative w orks of the Softw are; (iii) use the Softw are in any manner to provide service bureau, commercial time-sharing
or other computer services to third parties; (iv) transmit the Softw are or provide its functionality, in w hole or in part, over
the Internet or other netw ork (except as expressly permitted); (v) use the Softw are for any purpose other than solely for
your internal research except as may be otherw ise agreed in w riting by CRI; (vi) use the Softw are to provide any
analytics or diagnostics or otherw ise for the benefit of any third party except as may be otherw ise agreed in w riting by
CRI; or (vii) sell, distribute, rent, lease, sublicense or otherw ise transfer the Softw are to a third party.
3. Ow nership of Softw are. CRI and/or its suppliers ow n all right, title and interest, including all copyrights, trademarks,
tools, know -how , and processes in and to the Softw are. The Softw are contains confidential information and trade
secrets of CRI. You (i) acknow ledge, and agree not to contest, CRI's rights in the Softw are; and (ii) agree not to disclose
any confidential information of CRI regarding the Softw are or that is otherw ise disclosed to you in connection w ith this
Agreement. You recognize that the covenants contained in this License are reasonable and necessary to protect the
legitimate interests of CRI, that CRI w ould not have entered into this Agreement in the absence of such covenants, and that
your breach or threatened breach of such covenants shall cause CRI irreparable harm and significant injury, the amount of
w hich shall be extremely difficult to estimate and ascertain, thus, making any remedy at law or in damages inadequate.
Therefore, you agree that CRI shall be entitled, w ithout the necessity of posting of any bond or security, to the issuance of
injunctive relief by any court of competent jurisdiction enjoining any breach or threatened breach of such covenants and
for any other relief such court deems appropriate. This right shall be in addition to any other remedy available to CRI at law
or in equity.
4. Term ination. The license granted in Section 1 above is effective until terminated. This Agreement is conditioned upon
your continued compliance w ith the terms and conditions hereof and w ill terminate automatically w ithout notice from CRI if
you fail to comply w ith any term or condition of the Agreement. Furthermore, CRI may terminate this Agreement at any time
upon thirty (30) days notice. Upon termination of this Agreement, you shall immediately destroy all copies of the Softw are
(including all accompanying documentation) and any other confidential and proprietary information you have received
during or in connection w ith this Agreement.
5. Lim ited Warranty. CRI w arrants that the media on w hich the Softw are is provided w ill be free from defects in materials
and faulty w orkmanship under normal use for a period of ninety (90) days from the date of delivery. Your exclusive
remedy under this Section 6 shall be, at CRI's option, a refund of the price paid for the Softw are or replacement of the
media on w hich the Softw are w as provided so long as that media has been returned to CRI under a CRI-issued return
authorization. CRI shall have no responsibility to replace media damaged by accident, abuse or misapplication.
6. No Other Warranties. EXCEPT FOR THE LIMITED WARRANTY STATED IMMEDIATELY ABOVE, THE SOFTWARE IS
PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, AND CRI EXPRESSLY DISCLAIMS ANY AND ALL IMPLIED
WARRANTIES, INCLUDING WITHOUT LIMITATION ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE OR NON-INFRINGEMENT OF THIRD PARTY RIGHTS. CRI DOES NOT REPRESENT OR WARRANT THAT THE
RESULTS OR THE USE OF THE SOFTWARE WILL BE CORRECT, ACCURATE OR RELIABLE, OR THAT THE SOFTWARE
WILL OPERATE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. YOU
ASSUME ALL RISK ASSOCIATED WITH THE USE, RESULTS AND PERFORMANCE OF THE SOFTWARE.
7. Lim itation of Liability. IN NO EVENT SHALL CRI, ITS AFFILIATES OR SUPPLIERS, OR THEIR RESPECTIVE EMPLOYEES,
OFFICERS OR AGENTS, BE LIABLE FOR ANY DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
SOFTWARE, INCLUDING WITHOUT LIMITATION INCIDENTAL, SPECIAL, CONSEQUENTIAL, PUNITIVE, EXEMPLARY,
INDIRECT OR DIRECT DAMAGES (INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA,
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RE-RUN TIME, INACCURATE INPUT, WORK DELAYS, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES
OR LOSSES), WHETHER IN AN ACTION IN CONTRACT, TORT (INCLUDING NEGLIGENCE AND STRICT LIABILITY) OR
OTHERWISE, AND EVEN IF CRI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND REGARDLESS OF
WHETHER ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE. CRI’s AGGREGATE LIABILITY ARISING OUT OF OR
RELATING TO THIS AGREEMENT, FOR ANY AND ALL DAMAGES THAT YOU MIGHT INCUR (REGARDLESS OF THE FORM
OF ACTION GIVING RISE TO SUCH LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE) SHALL NOT EXCEED [ONE
HUNDRED DOLLARS ($100)]. Some jurisdictions do not allow the exclusion or limitation of liability for consequential or
incidental damages. In such jurisdictions, our liability is limited to the greatest extent permitted by law , or the amount you
paid for your purchase, w hichever is less.
8. U.S. Governm ent End Users. The Softw are qualifies as commercial computer softw are for purposes of the Federal
Acquisition Regulations (FAR) §52.227-19 and the Department of Defense Supplement to the FAR (DFARS) §52.227.7013.
If the Softw are is acquired by a civilian government agency, it is furnished w ith only the minimum Restricted Rights
provided by FAR 52.227-19. If the Softw are is acquired by a military agency, it is furnished w ith only the minimum
Restricted Rights provided by DFARS 52.227-7013(c)(1)(ii).
9. Miscellaneous. This Agreement contains the entire agreement of the parties w ith respect to the subject matter hereof
and supersedes any proposal or prior agreement, w ritten or oral, and any other communications betw een the parties
relating to the subject matter hereof. No modification or w aiver of any provision of this Agreement shall be effective
unless in w riting and signed by the parties. No delay or failure on the part of any party in exercising any right under this
Agreement shall impair any such right or any remedy of such party, nor shall it be construed to be a w aiver of any
continuing breach or default under this Agreement. In the event any provision of this Agreement is held to be
unenforceable, the remaining provisions of this Agreement w ill remain in full force and effect. This Agreement shall be
governed by the law s of the State of New York w ithout regard to principles of conflicts of law s. Any disputes relating
hereto shall be adjudicated only in the state or federal courts in New York County, New York State, and you hereby
consent to the exclusive jurisdiction of those courts. This Agreement shall not be governed by the United Nations
Convention on Contracts for the International Sale of Goods, the application of w hich is expressly excluded. You may not
assign or otherw ise transfer this Agreement or any of your rights or obligations therein w ithout the prior w ritten consent
of CRI. You may not use the Softw are for any unlaw ful purpose nor export or re-export the Softw are except as
authorized by law .
10.TIFF m odule: This softw are uses the LibTIFF 4.0.3 library (http://w w w .libtiff.org/m isc.htm l)
The TIFF module used is Copyright © 1988-1997 Sam Leffler Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this softw are and its documentation for any purpose is hereby granted
w ithout fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the softw are
and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the softw are w ithout the specific, prior w ritten permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE,
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA
OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
11. This softw are uses the Vigra 1.6.0 library (http://hci.iw r.uni-heidelberg.de/vigra/)
This softw are includes machine-executable object code generated by a source language processor from the Vigra
libraries covered by the VIGRA license. These libraries have not been modified by CRI and all rights are reserved by the
copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its
suitability for any purpose.
The Vigra library is Copyright © 2008, Ulrich Kothe, Heidelberg Collaboratory for Image Processing
The VIGRA License
=================
(identical to the MIT X11 License)
Permission is hereby granted, free of charge, to any person obtaining a copy of this softw are and associated
documentation files (the "Softw are"), to deal in the Softw are w ithout restriction, including w ithout limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Softw are, and to permit persons to

Software EULA

101

w hom the Softw are is furnished to do so, subject to the follow ing conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Softw are.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
12. This softw are uses the Boost 1.53.0 library (http://w w w .boost.org/ )
This softw are includes machine-executable object code generated by a source language processor from the Boost
libraries covered by the Boost license. These libraries have not been modified by CRI and all rights are reserved by the
copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its
suitability for any purpose.
The Boost license is reproduced below :
Boost Softw are License - Version 1.0 - August 17th, 2003
Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the softw are and
accompanying documentation covered by this license (the "Softw are") to use, reproduce, display, distribute, execute, and
transmit the Softw are, and to prepare derivative w orks of the Softw are, and to permit third-parties to w hom the Softw are
is furnished to do so, all subject to the follow ing:
The copyright notices in the Softw are and this entire statement, including the above license grant, this restriction and the
follow ing disclaimer, must be included in all copies of the Softw are, in w hole or in part, and all derivative w orks of the
Softw are, unless such copies or derivative w orks are solely in the form of machine-executable object code generated by
a source language processor.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE
FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR
IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
13. This softw are uses the Quan 1.0.0 library (https://lists.sourceforge.net/lists/listinfo/quan-m atters)
This softw are includes machine-executable object code generated by a source language processor from the Quan
libraries covered by the Boost license. These libraries have not been modified by CRI and all rights are reserved by the
copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its
suitability for any purpose.
14. This softw are uses the Com m andLine 1.6.0.0 library (http://com m andline.codeplex.com )
This softw are makes use of the CommandLine libraries. These libraries have not been modified by CRI and all rights are
reserved by the copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim
as to its suitability for any purpose. The libraries are covered by the MIT License.
The MIT License is reproduced below :
The MIT License (MIT)
Copyright (c) 2005 - 2012 Giacomo Stelluti Scala
Permission is hereby granted, free of charge, to any person obtaining a copy of this softw are and associated
documentation files (the "Softw are"), to deal in the Softw are w ithout restriction, including w ithout limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Softw are, and to permit persons to
w hom the Softw are is furnished to do so, subject to the follow ing conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the
Softw are.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
15. This softw are uses the log4net libraries (http://logging.apache.org)
This softw are makes use of the log4net libraries. These libraries have not been modified by CRI and all rights are reserved
by the copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its
suitability for any purpose. The libraries are covered by the Apache License.
The Apache License is reproduced below :
Apache License
Version 2.0, January 2004
http://w w w .apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.
"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of
this document.
"Licensor" shall mean the copyright ow ner or entity authorized by the copyright ow ner that is granting the License.
"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under
common control w ith that entity. For the purposes of this definition, "control" means (i) the pow er, direct or indirect, to
cause the direction or management of such entity, w hether by contract or otherw ise, or (ii) ow nership of fifty percent
(50%) or more of the outstanding shares, or (iii) beneficial ow nership of such entity.
"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.
"Source" form shall mean the preferred form for making modifications, including but not limited to softw are source code,
documentation source, and configuration files.
"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but
not limited to compiled object code, generated documentation, and conversions to other media types.
"Work" shall mean the w ork of authorship, w hether in Source or Object form, made available under the License, as
indicated by a copyright notice that is included in or attached to the w ork (an example is provided in the Appendix below ).
"Derivative Works" shall mean any w ork, w hether in Source or Object form, that is based on (or derived from) the Work
and for w hich the editorial revisions, annotations, elaborations, or other modifications represent, as a w hole, an original
w ork of authorship. For the purposes of this License, Derivative Works shall not include w orks that remain separable
from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.
"Contribution" shall mean any w ork of authorship, including the original version of the Work and any modifications or
additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by
the copyright ow ner or by an individual or Legal Entity authorized to submit on behalf of the copyright ow ner. For the
purposes of this definition, "submitted" means any form of electronic, verbal, or w ritten communication sent to the Licensor
or its representatives, including but not limited to communication on electronic mailing lists, source code control systems,
and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and
improving the Work, but excluding communication that is conspicuously marked or otherw ise designated in w riting by the
copyright ow ner as "Not a Contribution."
"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of w hom a Contribution has been received by
Licensor and subsequently incorporated w ithin the Work.
2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You
a perpetual, w orldw ide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare
Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in
Source or Object form.
3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a
perpetual, w orldw ide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license
to make, have made, use, offer to sell, sell, import, and otherw ise transfer the Work, w here such license applies only to
those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by
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combination of their Contribution(s) w ith the Work to w hich such Contribution(s) w as submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a law suit) alleging that the Work or a Contribution
incorporated w ithin the Work constitutes direct or contributory patent infringement, then any patent licenses granted to
You under this License for that Work shall terminate as of the date such litigation is filed.
4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, w ith or
w ithout modifications, and in Source or Object form, provided that You meet the follow ing conditions:
(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and
(b) You must cause any modified files to carry prominent notices stating that You changed the files; and
(c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and
attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the
Derivative Works; and
(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must
include a readable copy of the attribution notices contained w ithin such NOTICE file, excluding those notices that do not
pertain to any part of the Derivative Works, in at least one of the follow ing places: w ithin a NOTICE text file distributed as
part of the Derivative Works; w ithin the Source form or documentation, if provided along w ith the Derivative Works; or,
w ithin a display generated by the Derivative Works, if and w herever such third-party notices normally appear. The
contents of the NOTICE file are for informational purposes only and do not modify the License. You may add Your ow n
attribution notices w ithin Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the
Work, provided that such additional attribution notices cannot be construed as modifying the License.
You may add Your ow n copyright statement to Your modifications and may provide additional or different license terms
and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a w hole,
provided Your use, reproduction, and distribution of the Work otherw ise complies w ith the conditions stated in this
License.
5. Submission of Contributions. Unless You explicitly state otherw ise, any Contribution intentionally submitted for inclusion
in the Work by You to the Licensor shall be under the terms and conditions of this License, w ithout any additional terms or
conditions. Notw ithstanding the above, nothing herein shall supersede or modify the terms of any separate license
agreement you may have executed w ith Licensor regarding such Contributions.
6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product
names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and
reproducing the content of the NOTICE file.
7. Disclaimer of Warranty. Unless required by applicable law or agreed to in w riting, Licensor provides the Work (and each
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either
express or implied, including, w ithout limitation, any w arranties or conditions of TITLE, NON-INFRINGEMENT,
MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated w ith Your exercise of permissions
under this License.
8. Limitation of Liability. In no event and under no legal theory, w hether in tort (including negligence), contract, or
otherw ise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in w riting, shall
any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages
of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to
damages for loss of goodw ill, w ork stoppage, computer failure or malfunction, or any and all other commercial damages or
losses), even if such Contributor has been advised of the possibility of such damages.
9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to
offer, and charge a fee for, acceptance of support, w arranty, indemnity, or other liability obligations and/or rights
consistent w ith this License. How ever, in accepting such obligations, You may act only on Your ow n behalf and on Your
sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each
Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting
any such w arranty or additional liability.
16. This softw are uses the bzip2 program and libbizip2 libraries (http://w w w .bzip.org)
This softw are makes use of the bzip2 program and associated libbzip2 libraries. The program and libraries have not been
modified by CRI and all rights are reserved by the copyright holder. This softw are is provided "as is" w ithout express or
implied w arranty, and w ith no claim as to its suitability for any purpose. The libraries are covered by the follow ing license.
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The bzip2 license is reproduced below :
This program, "bzip2", the associated library "libbzip2", and all documentation, are copyright (C) 1996-2006 Julian R
Sew ard. All rights reserved.
Redistribution and use in source and binary forms, w ith or w ithout modification, are permitted provided that the follow ing
conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the follow ing disclaimer.
2. The origin of this softw are must not be misrepresented; you must not claim that you w rote the original softw are. If you
use this softw are in a product, an acknow ledgment in the product documentation w ould be appreciated but is not
required.
3. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original
softw are.
4. The name of the author may not be used to endorse or promote products derived from this softw are w ithout specific
prior w ritten permission.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
Julian Sew ard, Cambridge, UK.
jsew ard@bzip.org
bzip2/libbzip2 version 1.0.4 of 20 December 2006
17. This softw are uses the libjpeg-turbo 1.5.13 library (http://libjpeg-turbo.virtualgl.org)
This softw are makes use of the libjpeg-turbo library. This library has not been modified by CRI and all rights are reserved
by the copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its
suitability for any purpose. The library is covered by the libjpeg-turbo License. Additionally libjpeg-turbo incorporates parts
of libjpeg w hich is covered by the BSD license.
The libjpeg-turbo license is reproduced below :
Redistribution and use in source and binary forms, w ith or w ithout modification, are permitted provided that the follow ing
conditions are met:
- Redistributions of source code must retain the above copyright notice, this list of conditions and the follow ing disclaimer.
- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the follow ing
disclaimer in the documentation and/or other materials provided w ith the distribution.
- Neither the name of the libjpeg-turbo Project nor the names of its contributors may be used to endorse or promote
products derived from this softw are w ithout specific prior w ritten permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS", AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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The BSD for libjpeg license is reproduced below :
The authors make NO WARRANTY or representation, either express or implied, w ith respect to this softw are, its quality,
accuracy, merchantability, or fitness for a particular purpose. This softw are is provided "AS IS", and you, its user,
assume the entire risk as to its quality and accuracy.
This softw are is copyright (C) 1991-2010, Thomas G. Lane, Guido Vollbeding.
All Rights Reserved except as specified below .
Permission is hereby granted to use, copy, modify, and distribute this softw are (or portions thereof) for any purpose,
w ithout fee, subject to these conditions:
(1) If any part of the source code for this softw are is distributed, then this README file must be included, w ith this
copyright and no-w arranty notice unaltered; and any additions, deletions, or changes to the original files must be clearly
indicated in accompanying documentation.
(2) If only executable code is distributed, then the accompanying documentation must state that "this softw are is based in
part on the w ork of the Independent JPEG Group".
(3) Permission for use of this softw are is granted only if the user accepts full responsibility for any undesirable
consequences; the authors accept NO LIABILITY for damages of any kind.
These conditions apply to any softw are derived from or based on the IJG code, not just to the unmodified library. If you
use our w ork, you ought to acknow ledge us.
Permission is NOT granted for the use of any IJG author's name or company name in advertising or publicity relating to this
softw are or products derived from it. This softw are may be referred to only as "the Independent JPEG Group's
softw are".
We specifically permit and encourage the use of this softw are as the basis of commercial products, provided that all
w arranty or liability claims are assumed by the product vendor.
18. This softw are uses the zlib1 1.2.7 library (http://w w w .zlib.net)
This softw are makes use of the zlib1 library. This library has not been modified by CRI and all rights are reserved by the
copyright holder. This softw are is provided "as is" w ithout express or implied w arranty, and w ith no claim as to its
suitability for any purpose. The library is covered by the zlib1 License.
The zlib 1 license is reproduced below :
(C) 1995-2012 Jean-loup Gailly and Mark Adler
This softw are is provided 'as-is', w ithout any express or implied w arranty. In no event w ill the authors be held liable for
any damages arising from the use of this softw are.
Permission is granted to anyone to use this softw are for any purpose, including commercial applications, and to alter it and
redistribute it freely, subject to the follow ing restrictions:
1. The origin of this softw are must not be misrepresented; you must not claim that you w rote the original softw are. If you
use this softw are in a product, an acknow ledgment in the product documentation w ould be appreciated but is not
required.
2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original
softw are.
3. This notice may not be removed or altered from any source distribution.
Should you have any question concerning this Agreement, you may contact CRI by w riting to CRI, 68 Elm St., Hopkinton, MA
01748. You may also call +1-508-435-9500.
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Components to include
64
Composite Image, viewing
77
Contact PerkinElmer
13
Count data, viewing
85
Counting objects
71
Cytoplasm, segmenting
63

Index
-00-3+ (4-bin), scoring

68

-D-

-AAbout inForm
7
Adding images to a project
31
Algorithm
10, 30
Creating for Vectra
94
Definition
10
Opening
30
Saving
30
Analysis process editor
15
Auto scale
60
Available Images Window
21

-BBatch Analysis tab
19
Batch processing
91

Data
Displaying extracted
73
Exporting
89
Merging
93
Down-sample
35
Drawing Processing Regions
34
Drawing training regions
48

-EEditing masks
52
Excel
97
Export settings
89
Exporting the data
89
Extracted Data, viewing

73

-F-

-CCalculating Fractional Tissue Area
97
Categories, adding
47
Cell segmentation data, viewing
80
Cells, segmenting
59
Classifiers
94
Classifying Tissue
automatically
47
manually
44
Colocalization
57
Colocalization data, viewing
84
Color Image view
73
Compartment
66
Component data
Viewing
73
Component for scoring
66
Component units
39
component view
74
Components for training
49

Features
7
Fifty-bin, scoring
70
Fill holes
62
Fine tuning, segmenter
51
Fixed scale
60
Fractional Tissue Area, calculating

97

-HHaze spectra, removing
38
HPF finder algorithm
94

-IID number
34
IF scoring
66
IHC scoring
66
Image
Display area
18
Index
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Image
Displaying
73
Format
35
Viewing
32
Image analysis tasks, summary of
Images
Adding to a project
31
Adding to a training set
51
Opening
31
Opening in a project
31
inForm Algorithms
94
inForm window
14
Inner distance to nucleus
63
Installing inForm
11
Introduction to inForm
7

26

-PPattern scale, selecting
49
Percent total area
97
PerkinElmer Technical Support
PivotTable
97
Pixel-based approach
59
Positivity, scoring
67
Printed documentation
11
Process step bar
14
Processing Regions
31
Deleting
34
Drawing
34
Project
10
Adding images
31
Creating New
27
Definition
10
Open
29
Opening images
31
save
29

-KKey Terms

10

-LLicense, activating

12

-MMasks, editing/re-training
52
Maximum size
61, 65
Maximum size (pixels)
62
Membrane, segmenting
64
Merge editor
19
Merging the data
93
Minimum size
61, 63, 65

13

-QQuant data, viewing

86

-R-

-NNew project
27
New Project Window
22
Nuclear segmentation components
Nuclei size range
61, 65
Nuclei, segmenting
59

-OObject-based approach
Objects, counting
71
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Online documentation
11
Open
Algorithm
30
Project
29
Opening images
31
Opening images in a project
31
Optical density, converting to
37
Outer distance to nucleus
63
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61, 64

Recent trainings
50
Reference white
36
Refine splitting
62
Region ID number
34
Removing images from a project
Re-training
52
roundness (minimum circularity)
roundness, minimum circularity

31
62
62

-SSample format
35
Saving
algorithms
30
projects
29
Score data, viewing
82
Scoring IHC or IF
66
Scoring type
66
Segmentation Priority
65
Segmentation resolution
50
Segmenter training
50
Segmenting cells
59
Segmenting cytoplasm
63
Segmenting membrane
64
Segmenting nuclei
59
Segmenting tissue
47
Segmenting tissue, training
51
Select Reported Units
39
Signal scaling
60
Specifications
7
Spectra for unmixing (selecting)
37
Spectral Library
loading
36
viewing
39
Spectral Library window
24
Support, Technical
13
Supported image formats
7

Tissue segmentation
47
Tissue segmentation data, viewing
78
Tissue Segmenter, definition
10
Tissue Segmenter, training
49
Toolbars
16
Training regions, drawing
48
Training Set
Adding images
51
Training the tissue segmenter
49
Transferring the license
12

-UUnmixing. spectra for
User interface
14

36

-VView Editor

19

-WWeighting
Welcome

39
6

-TTechnical Support
13
Ten-bin, scoring
69
Threshold
54
Threshold maximum
66
Tissue
automatically classifying
47
manually classifying
44
Tissue Categories
Creating
47
Deleting
47
Tissue Category
Definition
10
For scoring
66
Selecting
60
Tissue finder algorithm
94
Index
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For more information, contact PerkinElmer or your local authorized PerkinElmer distributor:
PerkinElmer, Inc.
68 Elm Street, Hopkinton, MA, 01748, USA
Phone: 800-762-4000 or +1 203-925-4602
Fax: +1 203 925-4904
Email: global.techsupport@perkinelmer.com
Web site: http://www.perkinelmer.com
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